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Handsonlabh 1.
Kentico Enterprise Marketing Solution: Campaigns

Lah Overview

System Requirements:

o Kentico CMS 7 Enterprise Marketing Solution installed with the Sample
Corporate Site

Intended Lab Audience:

e Online Marketers
e CMS Designers

Lab Introduction

Executing successful campaigns is an essential part of any marketing organization.
Campaigns are a way to engage and interact with your customers. They provide an ideal
mechanism to generate sales leads and collect customer information. This set of
exercises is intended to show the process of creating a document based campaign for
the Services page that collects customer information using an online form. Then using
the collected customer information we will then score the leads for later use by the
sales department. In completing this set of labs you will perform the following tasks:

e Create an Online form for collecting customer information
e Create a squeeze page for collecting customer information
o Create a Services campaign

e C(Create conversions

e Create a lead score

e Optimize a campaign using A/B tests
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Lah 1-1: Creating the online form

Online forms are the easiest way to create a contact information form for the live site
without having to write application code. Forms are built using a data driven interface
and then inserted into the page using the Online form web part. In this lab we will
create the contact information form and then insert it into the Services page, which is
then used as the main campaign landing page.

Lab 1-1: Creating an online form
1. Loginto CMS Desk and select the Tools tab and then click the Add a new form
link as shown in the following screenshot.

Me Kentico
Fa

CMS Desk Content My desk : Administration E-commerce

|§| @ Polls [} Custom tables 84 Forums Messag
Forms  Media ™§ Staging [EJ File import Blogs  §a Groups @ Abusen

Content Community

Forms |

Add a new farm

E] Media )
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2. Inthe New form dialog in the Form display name field enter Campaign Contacts
and then click the Save button as shown in the following screenshot.

@ New Form

» Forms » Mew Form

E Save

Form display name: Campign Contacts

© i

Form code name:  (automatic)

Tahle name: Form_CorporateSite_ (automatic)

3. Inthe Campaign Contacts form in the General tab update the following fields
and then select Save.

Section Field Value

After the form is submitted Display text We will contact you shortly

Submit button text Submit

4. Select the Fields tab, click the Add new attribute (+) button, update the
following fields and then click the Save button.

Section Field Value
Simple mode Column name First_name
Simple mode Field caption First name
Simple mode Field type Textbox
Simple mode Maximum length 20
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5. Select the Add new attribute (+) button, update the following fields and then
click the Save button.

Section Field Value
Simple mode Column name Last_name
Simple mode Field caption Last name
Simple mode Field type Textbox
Simple mode Maximum length 30

6. Select the Add new attribute (+) button, update the following fields, and then

click the Save button.

Section

Field

Value

Simple mode

Column name

Email_address

Simple mode

Field caption

Email

Simple mode

Field type

E-mail
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7. Select the Add new attribute (+) button, update the following fields, and the
click the Save button.

Section Field Value

Simple mode Column name Contact_type

Simple mode Field caption How can we help you?

Simple mode Field type Drop-down list

Editing control settings Type Options (one value; name
pair on each line-example
1;Blue)

Editing control settings Data source Services;Services <CR>
RFP; RFP

8. In the Fields tab confirms the list of fields as shown in the following
screenshot.

Form Properties

» Forms » Campign Contacts

Data  General Fields | Form  Motif

CampignContactsIiD* ﬁ
First_name*
Last_name*
Email_address* 4}

FormUpdated*




Kentico Hands on Lab

9. Select the On-line marketing tab, click the Overwrite existing contact information
with submitted data. If unchecked, only empty values of a contact are filled check
box and then click the Save button as shown in the following screenshot.

Form Properties

» Forms » Campign Contacts
Autoresponder  Security  Alternative forms || On-line marketing | Versions

Data  General Fields Form  Motification e-mail

E Save

Log on-line marketing activity

| @, The following section allows mapping of the form's fields to contact objects. Data submitted through the form can then be used to initialize or update contact information.

| :"Overwrite existing contact information with submitted data. If unchecked, only empty values of a contact are filled.

General
First name: (none) [=] Last name: (none) [~]
Middle name (none) m Salutation: (none) |T|

In the On-line marketing tab update the following fields and then click the

10.
Save button
Section Field Value
General First name First_name
General Last name Last_name
Address E-mail Email_address
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Lab 1-2: Inserting the online form

1.

In CMS Desk select the Content tab, in the Content tree select the Services page,

then the Design tab, and in the Main zone select the Add web part icon (+) as
shown in the following screenshot.

= [ Copy

New

i up
& pown

Content management

= -
Delete = Hove

4 Global Admi ®  Signout

I Enterprise Marketing Soluti

Preview Live site List

View mode

&) corporate site
[[] Home
[ products
[ News
[] partners
Community
[ ) Services
& [ Company®
[0 Media
[] Examples
[1] mobile®
[] other
il Special Pages

2.

Form  Properties  Analytics

ign in to Global Admir

O IT Company

Home

nager. The default account is administrator with blank password.

Products News Community Company Media

J

Corporate Site - Text and placeholder with left menu

~ [Services - template:

k| |+ Main zone

| 1+ T Header text 3]

v Left zone

I+ T css list menu (]

In the Select web part screen select the Forms folder, the Online form web part

and then Ok as shown in the following screenshot.

#. Select web part |

ﬁ Recently used web parts
& Al web parts

) Abuse report

& Articles

& Attachments
Blogs
Community
Community services
Content rating
Custom tables
Data sources
Document library
E-commerce
Events & booking
Filters

BEHLELEELELDE

i

Forms
Forums
Full-text search

866
[}
5
[
o

[¥] search in description

Web part name:

—

=]

On-line form

On-line form

The On-line form web part allows you to insert your own on-line form on the page.
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3. Inthe Web part properties (On-line form) update the following value.

Section Field Value

Bizform settings Form name Campaign_Contacts

4. Select the Conversion tracking tab and then click the New button as shown in the

following screenshot.

" Web part properties (On-line form) @w
| General
| i . -
| Conversion tracking

Default e —| T

Track conversion name: 4 w i

| Visibility

BizForm settings
| g Conversion value: 3

Conversion tracking

Web part container

HTML Envelope Web part container

({¢

What is a conversion?

Conversions are specific actions performed by site visitors and recorded by the Web
analytics module. This is typically done for specific events you want to track or as part of
a broader campaign. Once you start tracking conversions on the live site, these can be
compared to other web analytics statistics like the amount of visitors. This allows you to
evaluate the website and adjust marketing strategies as necessary.
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5. Inthe New conversion screen in the Conversion display name field enter

Contactinfo and then select Save& close as shown in the following screenshot.

-

% .
{ New conversion

Conversion display name: Contactinfo r

Conversion code name:  (automatic)

Conversion description:

D

6. Inthe Web part properties (On-line form) screen in the Conversion value field enter

20 and then select Ok as shown in the following screenshot.

m Documentation

<; Web part properties (On-line form)

General

Default

Visibility

BizForm settings
Conversion tracking
Web part container

HTML Envelope

Refresh content

Conversion tracking

Track conversion name: » Contactinfo

Conversion value: v 20|

Web part container
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7. Confirm that you see the screen as shown in the following screenshot.

Page | Design | Form  Properties  Analytics Display web part content E
- ‘ Left zone |+ v|Mam zone |+
~ CSS list menu | &3 ~  Header text | {3
EEWICES
Web Design gbswte section consisting of this title page and three sub-pages. lts purpose is to display static
SrTrEtOTT a oo vices that the company provides

Web Development

\All pages in this section are created using the Page (menu item) document type and are stored as standard documents in
Kentico CMS content tree. The sub-pages are accessible by clicking the links in the left navigation, which is a part of the
page template used by this page. If you have a section like this on your website, Kentico CMS allows you to offer the listed
senvices to be purchased directly via the integrated web shop, as demonstrated in the Products - > IT senvices section

o s 3]

Last name:

Network Administration

Email:

How can we help you?: Senices -

Submit

8. Inthe upper right hand corner click the Sign out button as shown in the following
screenshot.

Live Site  Site Manager |Corporate Sitehd - Global Administrator v v7.0 RC ® Sign Out

J Enterprise Marketing Solution

9. On the Live site select the Services page, update the online form with your
contact information and select Submit as shown in the following screenshot.

First name: Thomas

Last name: Robbins

Email: thomasr@kentico.com

How can we help you? -
Submit

10
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10. Once the form is submitted validate that you see the following screenshot.

Services
This is a sample static website section consisting of this title page and three sub-pages. lts purpose is to display static information about the senvices that the
company provides.

All pages in this section are created using the Page (menu item) document type and are stored as standard documents in Kentico CMS content tree. The sub-
pages are accessible by clicking the links in the left navigation, which is a part of the page template used by this page. If you have a section like this on your
website, Kentico CMS allows you to offer the listed senices to be purchased directly via the integrated web shop, as demonstrated in the Products - > [T senices

section.

We will contact you shorthy!

11. Log into CMS Desk, select the Tools tab, then select Forms as shown in the

following screenshot

Content My " Tools Administration

@ Polls [l Custom tables B Fo
Forms  Media ™§ staging [§3 File import Blogs & crow
Content cc

Add a new form

11
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12. In the Forms screen select the Edit icon (pencil) for Campaign Contacts as shown in
the following screenshot.

Forms

@ Mew form

= Actions Form name = Entries

jk - Campign Contacts 1

j x - Contact Us 1]

13. Validate that you see the data as shown in the following screenshot.

» Forms » Campign Contacts

Data | General Felds Form  MNotification e-mail  Autoresponder  Security  Alternative forms  On-line marketing ~ Versions

[?d New record ﬁ Select displayed fields

~ Actions CampignContactsiD = First name Last name Email How can we help you? Form inserted Form updated

f x - 1 Thomas Robbins thomasr@kentico.com  Service 8/6/2012 311230 PM 8/6/2012 3:11:30 PM

12
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14. Click the On-line marketing tab, then select the Web analytics button, in the web

analytics list expand Campaigns & conversion, then expand Conversions and select
Overview as shown in the following screenshot.

Content My desk Tools Administration E-commerce On-line marketing

il conversions

My dashboard Web analytics | Scoring a Campaigns Activities  Contacts  Accounts  On-line us
Dashboard Analytics Contact management
ﬁgﬂ Web analytics
[ web analytics | B Conversions - Overview
m Dashboard
E; Visitors Report | Conversions
Traffic sources ; — -
? Content E Save @ Print [_ﬁ Delete data [d Subscribe
= '.P Campaigns & conversions
EE E = -
& campaigns . =
ik conversions
@ Overview Goal: Conversions count E Conversion: (all)
A2 conversion details
[&] Browser capabilities
5 Optimization

15. Validate that you see a report similar to the following screenshot.

1 ML A

C . “ , v ' v v
VR [ s s T 1L [T

Daye

[T [ omamy alae

Samgie e o a2

Beracnn page 1 m

== ] 0 ]

13
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Lah 1-2: Creating the Services campaign

Kentico EMS offers a variety of ways to create campaigns. Each is dependent on the type
and purpose of your marketing strategy. With the completion of the online form we are
now ready to create the document based campaign for the Services page. This campaign
includes page visits to the Services page and completion of the online form.

Lab 2-1: Create a document campaign
1. Select the Content tab, in the Content tree select the Services page, then click the
Analytics tab, Settings tab and in Track campaign select the New button as shown
in the following screenshot.

Page Design Form Properties | Anakytics |

» Analytics

Reporis Settings || A/B tests MVT tests MVT wvariants

E Save
I s

Track conversion name:

Conversion value:

2. Inthe New campaign dialog update the following fields and select Save & close.

Section Field Property
Campaign basic settings Campaign display name Services campaign
Campaign basic settings Open from Now
Campaign basic settings Open to Now + 2 weeks
Advanced campaign settings | Campaign impressions 20000
Advanced campaign settings | Total cost 10000

14
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3. Inthe Track conversion name click the New button as shown in the following

screenshot.

» Analytics

Reports Settings AB tests MVT tests MYT variants

E Save

Trckcampaar  Senices campaign I T

Conversion value:

4. In the New conversion dialog in the Conversion display name field enter Services
page and then select Save & close as shown in the following screenshot.

1 | -
i\ New conversion

Conversion display name: Services page

(5]
{automatic) @

Conversion code name:

Conversion description:

“Sove | ™ Savemciose | Close
r

15
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5. In the Conversion value field enter 10 and then select Save as shown in the
following screenshot

¥ Analytics

Reports Settings | A/B tests MVT tests  MVT variants

E Save

| Conversion value: 10

e
»
Why another conversion?

The Services page campaign includes two tracked conversions. The first we created
earlier with the online form. The Service page conversion tracks the traffic to the Services

page.

16
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Lab 2-2: Creating Campaign Data

1. Inthe upper right hand corner click the Sign out button as shown in the following
screenshot.

Live Site  Site Manager  [Corporate Siteld L Global Administrator v v7.0 RC 2 Sign Out

| Enterprise Marketing Solution

2. On the Live site select the Services page as shown in the following screenshot.

e Manager. The default account is administrator with blank p

Home ducts News Community Company Media

» Senvi

Web Design Services

3. Loginto CMS Desk, select the On-line marketing tab, and then the Web analytics
button as shown in the following screenshot.

:.‘ Kentico : Live Site

I‘ CMS Desk Content Mydesk Tools  Administration  E-commerce [OlRialanr-1eaial]

5 ! #8 conversions ‘ﬁ” & L;;L &g New contact
My dashboard Web analyhcs Scoring a Campaigns Activities Contacts Accounts & New account

Dashboard Analytics Contact management

17
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4. Inthe Web analytics list expand Campaigns & conversion, then expand Campaigns
and then select the Overview report as shown in the following screenshot.

ﬁg‘ﬂ Web analytics

Web analytics
[ Dashboard
& Visitors
{ Traffic sources
| Content

';'-ﬂ Campaigns & conversions
& Campaigns
| Overview |

2. Conversions count
LB?:]' Conversions value
(/O Campaign details
S Server campaigns
4 Goals

33 Conversions
Browser capabilities

5. Inthe Campaign drop down select the Services campaign and validate that you
see a report similar to the following screenshot.

a . .

t ;) Campaigns - Overview
Report | Campaigns =

A save 5 pint [ Delete gata

[ From: 107712011 o 1172011 © T

Campaign: Senvices Campaign -

Campaign views

18
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6. Select the Conversion count report as shown in the following screenshot.

ﬁg‘ﬂ Web analytics

Web analytics
[ pashboard
£a visitors
@ Traffic sources
‘| Content
P3 Campaigns & conversions
&, Campaigns
F_J Overview
2. Conversions count
& Conversions value
(/O Campaign details
S Server campaigns
4 Goals
i’; Conversions

7. Inthe Campaign dropdown select the Services campaign, then in the Conversion
dropdown select the Service page and validate that you see a report similar to

the following screenshot.

3. Campaigns - Conversions count
Seocet | Carowern
Hone & pont (8 Dolets cata

= From: 101422011 Te 191142011

TEEEE
© Conersion YT -

Lcmnmw Sendces campaion

Conversions count
1

02821 NN

TR e T
Days
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Lah 1-3: Optimizing Campaigns with A/B testing

As a campaign progresses it’s important to continually evaluate and refine. This can
often include page elements like messaging and typography to find better ways to
engage site visitors. In this lab we will create an A/B test of our services page as a way to
increase our campaign conversions. Within Kentico EMS the first step is to create the
A/B test and then create the variant page that will be used for the testing process.

g

>

What's the difference between A/B and MVT Testing?

A/B testing is different than MVT Testing. An A/B test uses a combination of pages and
tests elements like copy text, layouts, images and colors. MVT Testing is focused on web
part zones, web parts, and widgets.

Lah 3-1: Creating the A/B test
1. Select the Content tab, in the Content tree select the Services page, select the
Analytics tab, select the A/B tests tab and click the New test link as shown in the
following screenshot

]
.:!:. entico

1 CMS Desk ¢ Tools Administration E-commerce On-line marketing
Co u

_ j B o T (4| = A

New Delete = Move L Down Edit Preview  Live site List Search
Content management View mode Other

'p_ii Corporate Site Page Design Form  Properties | Analytics |

a Home Analvi

= nalytics

|| Products ’ i

a News Reports Settings || A/B tests MVT tests MVT vanants

a Partners =

|| Community | New test

[l services

i No data found.
] Company™

[ Media

20
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2. Inthe New test screen update the following fields and then select the Save

button.
Field Value
Display name AB Services
Target number of conversions 100
Test from Now
Test to Now + 2 weeks
Test enabled Checked

21
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Lab 3-2: creating the variant page

1. With the Services page selected in the Content tree, select the New button as
shown in the following screenshot.

Me Kentico

P18  CMS Desk Content

;‘ [ copy T Up
New | Delete < Move & Down

Content management

2. Inthe New document screen at the bottom select the A/B test page variant link as
shown in the following screenshot.

%] Link an existing document

‘@ A/B test page variant

3. Update the following fields and then select the Save button.

Field Value

Document name AB_Services

Assign to A/B test AB Services

22
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4. Select the Page tab in the Editable region add the text This is the variant page and
then select the Save button as shown in the following screenshot.

' Kentico

Y

sle
iy

CMS Desk

i up

My desk  Tools Administration E-commerce

On-line marketing

= B . .
S 0w 2 = P
Mew Delete | Move J} Down Edit Preview  Live site List Search
Content management View mode Other
!:‘_Fi Corporate Site Page || Design Form  Properties  Analytics
D Home
[ News ) '
[ partners El Source | P Bk @ |0
[[] Community Styles +~ MNormal  ~  Font v Size v A A~ | )
[ services

[] AB_Services
a Web Desian
[ ] Web Development
[1] Network Administration
D Company
[ Media
D Examples
[} Mobile*
[] other

i) Snerial Panes

V¥ bt L Ve e L

Network Administration

iThis is a sample static website se
ithe services that the company pro

EAII pages in this section are create
icontent tree. The sub-pages are &
ipage. If you have a section like th

: demonst
|This is the variant page|

5. Inthe Content tree select the Services page, then select the Analytics tab, then
the A/B tests tab and for the AB Services test click the Edit (pencil) icon as shown
in the following screenshot.

;L‘J Corporate Site Page Design Form  Properties | Analytics |
D Home Analvii
[ Products > Analytics
D Mews Reports Settings || A/B tests | |MVT tests MVT wvariants
D Partners g
[ Community o New test
= ] Services"
Q AB Services = Actions  Test name
D Web Design ,. - AB Services

SRR TR SN [Py

23
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6. Select the Variants tab as shown in the following screenshot.

Page [Cresign Form Properties | Analytics

» Analytics

Reports Settings A/B tests MYT tests MVT variants

» A/B tests » AB Services

General | | Variants | Reports

ﬁ. Mew variant

+ Actions Variant name = Test page Conversions
j x - AB Services variant  /Services ]

IR~ AB_Services /Services/AB_Services 0

What is this?

The variants tab shows the current page variants that are included as part of the running
AB Services test.

7. Inthe upper right hand corner click the Sign out button as shown in the following
screenshot.

Live Site  Site Manager |Corporate Sitehd - Global Administrator v v7.0 RC ® Sign Out

J Enterprise Marketing Solution

24
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8. On the Live site select the Services page as shown in the following screenshot

e Manager. The default account is administrator with blank password.

Home Products News Community 3 Company Media

> Senices

e

It’s random!

Remember the page received is random. Once you receive the Services page the cookie
distributed to your machine will always open the same page. If you have a second
browser available go ahead and try it!

25
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Lah 1-4: Scoring contacts

With the campaign running and proper demand generation our page will begin to
receive site visits and contact form submissions. Once leads are collected they can be
scored to show the weighting of their potential opportunities for our sales staff. In this
lab we will enter our contact information and then create an Activity based scoring rule.

Lah 4-1: Creating the contact
1. From the Live site select the Services page, in the Contact form enter your contact
information and click the Submit button as shown in the following screenshot

All pages in this section are created using the Page (menu item) document type and :
pages are accessible by clicking the links in the left nawigation, which is a part of the pa
website, Kentico CMS allows you to offer the listed senvices to be purchased directly viz
section

First name Thomas

Last name Robbins

Email thomrobbins@kentico.com

How can we help you? v
Submit

26
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2. Loginto CMS Desk as Administrator select the On-line marketing tab, click the
Activities tab and validate that you see the form submission as shown in the

following screenshot

Ilﬁw Activities

J_| Activities || Activity types

FAL New custom activity

Type (all) -

Title: LIKE -

Contact name: LIKE hd

IP address: LIKE hd

Time between: @M and @NL
&} ~ Actions  Title Type Contact name IP address
=] qx Form submitted ‘Contacts’  Form submission  Thomas Thomas  127.0.01
(=] Cé,x Page visit"Services’ Page visit Thomas Thomas  127.0.0.1
=] Cé,x Page visit' Home" Page visit Thomas Thomas  127.0.0.1

Activity time ~

11712011 11:44:53 AM
11712011 11:44:34 AM
117/2011 11:44:26 AM

3. Select the Contacts tab and then select the Edit icon (pencil) as shown in the

following screenshot

& Contacts

£ New contact

First name: LIKE -

Last name: LIKE -

E-mail: LIKE M

Contact status: (all) A
Show: @ All ) Only monitored ) Only non-monitored

~ Display advanced fitter

] ~ Actions  First name Last name = E-mail Contact status  Country

] Thomas Thomas thomasr@kentico.com

27
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4. Validate that you see the Contact properties as shown in the following
screenshot

Z Contact properties

» Contacts » Thomas Rebbins

General | Accounts  Membership  Activities IPs  Contactgroups  Scoring  Merge

ol sz

The changes were saved.

General

First name: Thomas Last name: Robbins
Middle name: Salutation

Title before: Title after:

Personal info

Birthday: @Now Jobtitle

Gender (unknown) ~ Created 1712011 11:44:26 AW

Contact settings

Contact status (none) - Contact owner:
Track activities: Campaign Semvices Campaign -

28
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Lah 4-2: Creating the scoring rules

1. Click the Scoring button and then select the New score link as shown in the

following screenshot.

3l¢ Kentico
#4N  OMS Desk Content Mydesk Tools Administration  E-commerce [ReBTHERNENE ]

- ol | Conversions d =75 5
. @ [5]8 ¢ @ &
My dashboard Web analytics | Scoring a Campaigns Activities Contacts Accounts On-line users
Dashboard Analytilﬁ Contact management

Scoring

2. Inthe New score screen in the Display name field enter Services and then click the

Save button as shown in the following screenshot.

%. New score

» Scoring * Mew score

. E Save

Display name: Services

Code name: (automatic)

2 OO

Description:

Enabled:

29
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3. Inthe General tab update the following fields and select the Save button.

Field Value
Send notification at score 20
Notification e-mail address Your email

13

Why enter another score?

When a contact score reaches the value of 20, a notification email is automatically
generated to the email address specified.

4. Select the Rules tab and select the New rule link as shown in the following
screenshot

E’fg Score properties

» Scoring » Services

Contacts  General || Rules
ﬁ. Mew rule

Mo data found.

30



Kentico Hands on Lab

5. Inthe New rule screen update the following fields .

Field Value
Display name Campaign contacts
Value 20
Rule Type Activity

{4

What is the rule type?

Rules are used to segment contacts for scoring. Kentico EMS supports two types of rules.
Attribute based rules look for similarities in system values. Activity rules are based on the
completion of a specific activity.

6. Update the following fields and then select the Save button.

Section Field Value
Rule Settings Activity Form Submission
Activity details Form Campaign Contacts
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7. Select the General tab and click the Recalculate link as shown in the following
screenshot

%_gl Score properties

» Scoring » Services

Contacts | General | Rules

E Save g Recalculate

Score info
Display name Senices

Status: Recalculation required
Code name Services

Last recalculation fime: N/A

Description:

Enabled
Send notification atscore: 20

e-mail address: th R@kentico com
Schedule rebuild: ]

8. Click the Contacts tab and validate that you see your contact information as
shown in the following screenshot

» Scoring » Senvices

Contacts | General FRules

Score; == A

—Searcn |
= Actions Full name Contact status Score
[l & Thomas Robbins 20

Selected contacts * (selectan action) - _m
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Summary

In this set of Hands on Labs we looked at how to create a campaign and collect
customer information. We then looked at how we can optimize this campaign further
with an A/B test. Specifically, we covered the following.

e Creating an online form

e Linking an online form to contacts with EMS
e (Creating a document campaign

e Creating an A/B test

e Collecting contact information

e Scoring contacts

Key Resources:

e http://devnet.kentico.com/Documentation.aspx

e http://devnet.kentico.com/Videos/ABTest.aspx
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Hands on Lab 2
Custom Table: Create and Display

Lah overview

System Requirements:
e Kentico CMS 7 with the Sample Corporate Site
Intended Lab Audience:

e CMS Designers
e CMS Developers

Lab introduction

Kentico CMS provides custom tables as a way to store and manage custom data.
Technically, they are SQL tables and coupled stored procedures. Once a custom table is
created and contains data, the next step is to provide a display for site visitors. In this
lab we will add a custom table and then use the Basic Repeater web part to display it on
a page. We will also look at how to use the Kentico CMS API to add and edit an existing
item. In completing this set of labs you will perform the following tasks:

e Create a custom table

e Explore the Data Source web part

e Explore the Basic Repeater web part

e Edit a transformation for better visual display

e Add a new item to the custom table using the Kentico CMS API
e Edit an existing item using the Kentico CMS API
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Lah 2-1: Creating a custom tahle

1. As Administrator log into CMS Site Manager, select the Development tab, then
select Custom tables, and click New custom table as shown in the following

screenshot.

.
1N Site Manager Sites  Administration  Setting DETELLIGE @ Tools  Dashboard  Licenses  Support  Buy
Development ﬁ Custom tables

@ Countries

&j €SS stylesheets F Mew custom table

3 cultures

& gtting - =
— = - Actions = Display name =  Code name Table name
fill Custom tables
f x - Sample table customtable.SampleTable  customtable_SampleTable

L/ Device profiles
ﬁ]! Document types

2. In Step 1- General update the following fields and then click Next.

Field Value
Custom table display name Customer Contacts
Custom table code name (custom table) custom
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3. In Step 2 — Data type click Next as shown in the following screenshot.

Data type

Step 2 Please supply name of the new database table and included fields.

Create a new database iable
1 Use an existing database table

Database table name: customtable_custom

Primary key name: Ite

Include ltemGUID field
Include IltemCreatedBy field:
Include ltemCreatedWhen field:
Include ltemModifiedBy field:
Include ltemModifiedWhen field:

Include ltemOrder field:

Next =

4. In Step 3 - Fields click the New attribute (+) button as shown in the following

screenshot.

Fields

StEP 3 Please define custom fields of the custom fable and their appearance in the editing form.

ﬁ E Save field

ltemCreaiedBy
ItemCreatedWhen
IltemModifiedBy @ B
ItemModified\When Database
ItemOrder . —
ltemGUID* Column name temID
Q Aftribute type Integer numbe
Attribute size:
Allow empty value (] =
EI Default value:
x Display atfribute in the editing form

Field appearance

Field caption: @
Quick links: Form control type: (ally
Database Form control:
Field appearance B
Validation Field description: o @
CSS styles

T
Next >
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5. Inthe New attribute (+) dialog update the following fields and then click Save.

Section Field Value
Database Column name Name
Database Attribute size 100
Field appearance Field caption Name
Field appearance Form control Textbox

6. Select the New attribute (+) button, update the following fields and then click

Save.
Section Field Value
Database Column name Title
Database Attribute size 100
Field appearance Field caption Title
Field appearance Form control Textbox

7. Select the New attribute (+) button, update the following fields, and then click

Save.
Section Field Value
Database Column name Email
Database Attribute size 100
Field appearance Field caption Email
Field appearance Form control E-mail
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8. In Step 2 —Fields validate that you see the new fields and then click the Next
button as shown in the following screenshot.

Fields

Please define custom fields of the custom table and their appearance in the editing form

liemID* ﬁ e save
@ Database 1
Column name: Email
Q Atfribute type Text =] £
Atiribute size: 100 1
ltemGUID* Allow emply value: ]
+ Default valua:

Translate field: (=]

®

Display aftribute in the editing form

Field appearance

Quick links: EE cation Email Q@
Dalabase Form control: E-mail |z|
Field appearance 3 " >

Editing control seftings bl -8
Validation

CSS styles

Field advanced seftings

9. InStep 4 - Sites click the Next button as shown in the following screenshot.

Sites

Step 4 Please select sites where this custom table can be used:

(=] Site name

= Corporate Site

Remove selected Add sites v

Next>
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10. In Step 5 — Search options click the Next button as shown in the following

screenshot.

Step 5

Search options
Please set search fields for Smart search module.

Title field: ItemID
Content field: (none)
Image field:  (none)
Date field: {none)

Set automatically
Field name
ItemiD
Name
Title
Email

ItemCreatedRy

Content

|3

188

Searchable

m@E @

q

Tokenized

=@

==

]

FEE]E]

m

‘Custom search name

11. In Step 6 — The wizard has finished click the Finish button as shown in the following

screenshot.
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Step 6 The wizard has finished

The setup has finished the following steps:

» The new custom fable was created.

» The sites were selected where this custom table can be used.
» The default queries were created.

¥ The default ASCX transformation was created.

¥ The default permission names were created.

» Custom table smart search specification was created.

12. In the Custom table properties screen click the Custom tables link as shown in the
following screenshot.

ﬁ Custom table properties

»|Custom tables [* Customer Contacts

General | Fields Form  Transformations  Queries  Sites  Alternative forms  Search fields Data  Versions

E Save

Custom table display name: Customer Contacts @
Custom table code name:  customtable . custom
namespace custom table
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13. In the Custom tables screen validate that the Customer Contacts custom table is
displayed as shown in the following screenshot.

ﬁ Custom tables

ﬁ Mew custom table

+ Actions Display name = Code name Table name
f x - Customer Contacts  customtable custom customtable_custom
f x - Sample table customiable.SampleTable  customtable_SampleTable
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Lah 2-2: Adding custom table data

1. As Administrator log into CMS Desk, select the Tools tab, then select the Custom
tables button as shown in the following screenshot.

;!c Kentico

1% CMS Desk Content Mydesk [@EWS Administration  E-commerce  On-line ma

E%] EJ @ Polls [} Custom tables &4 Forums Message boards
Forms Media #§ Staging ([ File import Blogs fa Groups e Abuse report

Content Community

2. Inthe Custom tables screen select the Edit (Pencil) icon for Customer Contacts as
shown in the following screenshot.

@ Custom tables

+ Actions Display name =

j Customer Contacis

rd Sample table

3. Inthe Custom table properties screen select the New item button as shown in
the following screenshot.

@ Custom table properties

» Custom tables *» Customer Contacts

. L8l Mew item @ celect displayad fields

Mo data found.
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4. Inthe New item screen update the following fields and then select the Save

button.
Field Value
Name Joe Brown
Title President
Email joe@company.com

5. Inthe Edit item screen click the Create another button, update the following
fields, and then click the Save button.

Field Value
Name Ted Thomas
Title Marketing VP
Email ted@company.com

6. On the Edit item screen click the Data link as shown in the following screenshot.

|3 Edit item

8 Data p Edit item

E Save [:.'ﬁl Create another

Mame: Ted Thomas
Title:  Marketing VP

Email: ted@company.com
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7. Inthe Custom table properties screen validate that the two items just entered

are visible as shown in the following screenshot.

ﬁ Custom table properties

» Custom tables » Customer Contacts

[8 newitem [ select displayed fields

Email

Created by

~ Actions ItemID Name Title
AT &~ 1 Joe Brown Prasident
FRET L~ 2 Ted Thomas  Markefing VP

joe@company.com

ted@company.com

Global Administrator (administrator)

Global Administrator (administrator)
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Lah 2-3: Creating the display page
1. In CMS Desk select the Content tab, in the Content tree select Company and then
click the New (Paper) icon, as shown in the following screenshot.

CMS Desk

(= > Copy Up
ot = T

New | Delete |5 Move b Down

Content management

lp_ﬁ! Corporate Site
[ about Us
Contact Us
Example ASPX
Home
Products
News
Partners
Community
Services

Company
Media -

1 Mmool ae

IiJLJ;JLJLIL.JLJLJL.JLJ

]

2. Inthe New document screen click the Page (menu item) as shown in the
following screenshot.

| New document

Please select new document type:

__| Page (menu item)

B Wireframe
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3. Inthe New Page (menu item) screen in the Page name enter Data Source, click
Create a blank page with layout, in the Layout name enter Simple, then click the
Search button, select the Simple page template, and finally click the Save button
as shown in the following screenshot.

ﬂ Save and create another Spell check

P

) Use existing page template () Use parent page template |@' Create a hlank page with layout | (") Create a blank page

| Layout name: Simple]| r m

Simple

4. Validate that you see the new Data Source page as shown in the following
screenshot.

Live Site  Site Manager  [GOfBOAEEISHEIEA A Global Administrator v v7.0RC @ | Sign Out

Administration  E-commerce i ! Enterprise Marketing Solution
= =) Copy Up ry -
5 @ 2o ¢ | L -
New Delete 3 Move & Down Edit Preview  Live site List Search
Content View mode Other .
) corporate Site Page | Design | Form Properties  Analytics Display web part content |7 |
B Home Signin to Sign into CMS anager The default account is administrator with blank password. a
- MS a X
[ products g 0 P All web parts @&
[ News i P
[ partners IT Company
[ Community ;. Abuse regort
Q Services Home Products News Community Services L Y
[ company Accordion layout =
2 » Company » Data Source
Careers s
- Data Source L admin actons
‘E]l v ‘ ICompany/Data Source - page template: ad-hoc
Offices
= He @] Analytics brawser capatities
1) Donate with Us zonelet
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Lab 2-4: Displaying custom table data

1. Inthe zoneLeft web part zone, click the Add web part icon (+) as shown in the
following screenshot.

lanager. The default account is administrator with blank password. Global Administrator (administrator) | L¢

Your shopping cart is empty
O IT Company e nnm

About Us Contact Us Example ASPX Home Products News Community Services ompany Media Training

» Company P Data Source I -

| iCompany/Data Source - page templat
| zoneLeft ||

2. Inthe Select web part screen select Data sources, then select the Custom table
data source web part, and then click OK as shown in the following screenshot.

#. Select web part |
% Recently used web parts “| web part name: m Search in description
) All web parts g
i) Abuse report
G Articles I I R —
| \' | \'
i) Attachments - | - | - | i
i Blogs — j =
i Community = =
i) Community services i
. Custom table data Department Documents data File system data
@ Content rating source members data source source
——SibeTa s source i
Ty DOCUme Brary
) E-commerce = (o = o
&) Events & booking C_-‘- \__-“‘- \_-“"-
&) Filters
&) Forms
@) Forums Forum posts data Friends data source Group forum posts Group media -
i) Full-text search T B
i) General
<) Google services Custom table data source
Intranet portal

9 P Loads data from a specified custom table and provides it as a data source, which can then be displayed by listing
) Layouts web parts (such as a Basic repeater).
) Listings and viewers
i Localization il

i
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3. Inthe Web part properties (Custom table data source) screen select the Data filter
tab, in the Custom table name field select the Customer Contacts

(customtable.custom) and then click Ok as shown in the following screenshot.

21 Web part properties (Custom table data source) @M
General
-
Data filter
Default
| Custom table name*: »  Customer Contacts (customtable.custom) E| |
Data filter |
Selection options ORDER BY condition: »
System settings —
Select Top M items: 3
WHERE condition: 3
[{F5

What is a data sources web part?

Data source web parts are used to connect and retrieve data from back end data sources
like custom tables. They retrieve data and pass them to display web parts. This
separation is designed to provide page based flexibility in data retrieval and display.
Data sources provide reusable sources of data. They reduce page resources as data is
retrieved just once and then can be used by different web parts on the same template to
display content.
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4. Inthe All web parts list enter Basic repeater and then click Search (magnifying
glass) as shown in the following screenshot.

L3

Al web parts (=] &8 |—

basic repsater pe,

&

Easic repeater

Basic repaater with effect

m

5. From the all web parts list drag the Basic repeater web part into the ZoneLeft web
part zone as shown in the following screenshot.

- | [Company/Data Source - page template: ad-hoc

- zoneleft "
"""""""""""" | E Basic repaater

v | 3 CustomTableDataSource {3
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6. Inthe Web part properties (Basic repeater) select the Content tab, and in the Data

source name field enter CustomTableDataSource as shown in the following

screenshot.
i Web part properties (Basic repeater) B Documentation
General

Content
Dctoilt Data source name* v CustomTableDataSource
Visibility
Transformations Transformations A
g

Connecting to Data Sources

The Data source name field is the connection between this web part and the data source
web part we added in Step 2 and must be an exact match.

7. Inthe Web part properties (Basic repeater) screen select the Transformation tab,
and in the Transformation name field click the Select button as shown in the
following screenshot.

Zi Web part properties (Basic repeater)

General
X .
Transformations

Default

Transformation name: »
Visibility
Content Alternating transformation name:  » mm

Item separator transformation =
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What is a transformation?
When data is passed from the data source web part to the Basic repeater a set of

formatting code (transformation) is applied to define the output that is displayed.

8. Inthe Select transformation dialog in the Class type drop down select Custom
table, in the Custom table drop down select Customer Contacts
(customtable.custom), then click the customtable.custom Default transformation as
shown in the following screenshot.

. Select transformation

Class type: Cusiom table E

({1510 RF: 1+ -l Customer Contacts (customiable custom) E
Transiormation name or its part: ﬁ

Transformation name

customtable. custom Default

customtable custom Preview

Items per page: 10 E

Where did these come from?

When we created the custom table the system automatically creates a Default and
Preview transformation
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9. Inthe Web part properties (Basic repeater) screen select Ok as shown in the
following screenshot.

s (Basic repeater)

General

Transformations

Transformation name: » customtable.custom Default mmm
visibility
Content Alternating transformation name:  » mmm E

Transformations

oot ransformetion [ Select [ Edit | New |
No data behavior IELLS

HTML Envelope

fon name: » e el
AIAX Footer transformation name:
Time zones

Performance

A Selected itam header . | coo o

)
i

Default

10. Validate that the data is displayed as shown in the following screenshot.

| Page | Design Form Properties  Analytics

Sign in to Signin to The default account is administrator with blank password.

O IT Company

Home Products News Community Services

» Company & Data Source

- FComEﬁlea Source - page teﬁlate: ad-hoc
v |zoneLeft

+ | BasicRepeater
e’ residen

Email: joe@company.com

Created by: 53

Created when: 7/18/2012 1:44:06 PM

Modified by: 53

Modified when: 7/18/2012 1:44:06 PM

Order: 1

GUID: e14f7c87-5b69-4c08-b3d7-710677609af4
Name: Ted Thomas

Title: Marketing VP

Email: ted@company.com

Created by: 53

Created when: 7/18/2012 1:45:25 PM

Madified by: 53

Modified when: 7/18/2012 1:45:25 PM

Order: 2

GUID: dcal47e5-e067-4082-bfea-fcb2ee392ebd

‘v| | 5| CustomTableDataSource |@|
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Lah 2-5: Editing the default Transformation

1. Inthe Design tab on the BasicRepeater web part select the Configure button as
shown in the following screenshot.

Page Dresign Form Properties  Analytics
- W m m lr' - . J-

Home Products News Community

» Company & Data Source

+ [Company/Data Source - page template: ad-hoc

+ zoneleft

v | BasicRepeater | {3
tle: Pres

2. Inthe Web part properties (Basic repeater) screen select the Transformation tab, in
the Transformation name field select the Edit button as shown in the following
screenshot.

Zi;; Web part properties (Basic repeater) E Documentation

General | Layout

Transformations

Default

Transformation name: + customtable.custom. Default mm
Visibility
Content Alternating transformation name:  » mm

i Transformations
1 Item separator transformation =

| » oot o | ew S
‘Web part container |
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3. Inthe Edit transformation dialog within the Code window replace the existing
code with the following, then select Save & close, and in the Web part properties
(basic repeater) window click OK.

<table border = "1" cellpadding="4">
<tr>
<td><b>Name:</b></td>
<td width="180"><%# Eval(''Name") %></td>
</tr>
<tr>
<td><b>Title:</b></td>
<td><%# Eval("Title") %></td>
</tr>
<tr>
<td><b>Email:</b></td>
<td><a href="mailto:<%#
Eva}("Ema11")%>?Subject=Contact%20Request">Send Mail</a></td>
</tr>
</table>

4, Select the Live Site button to view the edited transformation as shown in the
following screenshot.

2 [ || ~

Edit Preview Live site List Search

View mode Other

View | Validate

Sign in to CMS Desk. Sign i

O IT Comp

Home Products

» Company » Data Sou|

| Name: || Joe Brown |

|Title: || President |
|Email: HSend Mail ‘

Name: || Ted Thomas
Title: || Marketing VP
|Email: || send Mail ‘
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5. On the Live site click the Send Mail link for Joe Brown and validate that you see
the email as shown below.

B 0 O
Message Insert Options Format Text Review

From ~ Microsoft Exchange
El To... | joe@company . com
S5end
Cc... |
Subject: | Contact Request
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Lab 2-6: Adding custom table data with the API

1. In Visual Studio open the Kentico CMS Web project in the Solution Explorer right
click on the project root and select Add new item as shown in the following
screenshot.

Soluticn Explorer

i | (2] 8| & | 5]

“# C\..\KenticoCMST\

¥ Build Web Site
%, Publish Web Site

|.j Add New Item..

Ctrl+Shift+A I

2. Inthe Add new item dialog select Web form, in the Name field enter Tables.aspx,
and then click the Add button as shown in the following screenshot.

Add New Item - Chinetpub\wwwroot\KenticoCMSEY ? =
Installed Templates Sort by: | Search Installed Templates 2|

Visual Basic | Type: Visual C#

Visual C# -S| WebFom Visual C#
= Aform for Web Applications

Online Template
Ao ContentPoge Gz Vil C2

““@ Empty Page (Razor) Visual C#
Cﬂ@ Helper (Razor) Visual C&
c”@ Layout Page [Razor) Visual C#
C“@ Web Page (Razor) Visual C2
j Master Page Visual C#
= Web User Control Visual C#

% ADQ.NET Entity Data Model  Visual C#

Name: Tables.aspx | Place code in separate file
[ Select master page
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3. Inthe Tables.aspx form click the Design button as shown in the following

screenshot.
Lbody| g
4 13
O Split Source | E| <body> |E|

4. From the Toolbox drag the Button control onto Tables.aspx as shown in the
following screenshot.

File Edit View Website Build Debug Team Data Format Table Tools Test Analyze Window Help
i -Gl # Al 9 - - &5 b & [ Windows Phone 7 Emulator  -| | # [NewsMve EIEA
|7 24 |[None)  ~| | (Default Font)  ~||(Default -| | B £ U |

i () Install Web Components _ § | (New Inline Style)

Tables.aspi™ X

4 Standard
&k  Pointer
5 AdRotator
i=  BulletedLi
ﬁ Calendar
CheckBox
EE CheckBoxlList

E L
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5. Inthe Buttonl Properties window update the following fields

Field

Value

Createltem

Text

Create new item

6. On the Design tab double click the Create new item button as shown in the

following screenshot.

Tables.aspx

asp:button#Createlkem

Create new item

7. Atthe top of the Tables.aspx web form add the following Using statements.

using CMS.SettingsProvider;

using CMS.SiteProvider;
using CMS.DataEngine;
using CMS.CMSHelper;
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8. Inthe Createitem_click event replace any existing code with the following and
then select Save (CTRL+S).

CustomTableItemProvider ctiProvider = new
CustomTableItemProvider(CMSContext.Currentuser);
string customtablename = "customtable.custom";

DataClassInfo customTableClassIinfo =
DataClassInfoProvider.GetDataClass(customtabTlename);

if (customTableClassinfo == null)
throw new Exception("table does not exist.");
else

// Create item

CustomTableItem item =
CustomTabTleItem.New(customTableClassInfo.ClassName, ctiProvider);

// Set values

item.Setvalue("Name", "Thom Robbins");

item.Setvalue("Email", "thomasr@kentico.com");

item.Setvalue("Title", "Dish washer™);

// Insert the item

item.Insert();

9. With Tables.aspx selected in the Solution Explorer press the Start (Play) button as
shown in the following screenshot.

WebProject - Microsoft

File Edit View Website Build Debug Team Data Tools Test Analyze Window Help
[ R E R =) | EREE PR | 9 -0 S -ELE'& Windows Phone 7 Emulator | = |NewsM‘u‘C v| | Bl -
i 1@ Install Web Components _ i _ | % & Az (2 | =2 | &0 13 4 3 6 -

MRl Tables.aspr.cs* x MELES

4 General %4 Tables D
—lusing System;
using System.Collections.Generic;
using System.Ling;
using System.Web;
using System.Web.UI;
using System.Web.UI.WebControls;
// added
using CMS.SettingsProvider;
using CMS.SiteProvider;
using CMS.DataEngine;
using CM5.CMSHelper;

There are no usable controls in
this group. Drag an item onto
this text to add it to the toolbox,

[T TR R

[F 3]

=
=]
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10. In the running application click the Create new item button as shown in the
following screenshot.

B
K‘. x—') @I @ http://localhost:1469/KenticoCMS6/Tables.aspx

File Edit View Favorites Tools Help

v B v [ d& v Pagev Safetyv Toolsv @~ & [N] 53

| Create new item |

11. Log into CMS Desk then select the Tools tab and then select Custom tables as
shown in the following screenshot.

}'k Kentico

1% CMS Desk Content My desk Administration ~ E-commerce  On-line marketing

@ Polis | {4l Custom tables &4 Forums Message boards [§] Pé
Forms  Media ’VQ Staging [ File import Blogs & Groups @ Abuse report Projects Evenis

Content Community Collaboration

12. In the Custom tables menu select the Edit (Pencil) icon for the Customer Contacts
table as shown in the following screenshot.

@ Custom tables

+ Actions Display name =

f Customer Contacts

V4 Sample table

60



Kentico Hands on Lab

13. In the Custom table properties validate that the new custom table item is

available as shown in the following screenshot.

ﬁ Custom table properties

» Custom tables » Customer Contacts

[ Newitem | [JH Select displayed fields

~ Actions ItemID Name Title Email Created by

fx qﬁ i 3 ~ 1 Joe Brown President joe@company_com Global Administrator (administrator)
R AT~ 2 Ted Thomas Marketing VP ted@company.com Global Administrator (administrator)
|/ x —’Ck T &= 3 Thom Robbins  Dish washer thomasr@kentico.com  Global Administrator (administrator)
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Lah 2-7: Editing custom table data using the API
1. Onthe Tables. aspx form on the Design tab from the Toolbox drag a Button
control onto the form as shown in the following screenshot.

R — |

File Edit View Website Build Debug Team Data Format Table Tools Test Analyze Winc
- AT Rt = | 4 =2 B | o B ol == | b [ |Windows Phone 7 Emulator |
I@I]nstallWeh Components  _|i |(Neer1|ir1e Style) v| a0 | |(N0nej v| |(Defau|t Font) v|

: 1 Tables.aspx™
4 Standard o | asp:button#Buttond |
R Pointer Create new item -Eutton Il
[ AdRotator = el
i=  Bulleted|jst=—=
Button
E Calendar
2. Inthe Button 1 Properties update the following fields
Field Value
ID Editltem
Text Edit item

3. Double click the Edit item button as shown in the following screenshot.

Tables.aspx™ >

lacp-huttonZPdithem |

Create new item Edit item
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4. In the Edititem_Click event replace any code with the following and then select
Save (CTRL+S).

CustomTableItemProvider ctiProvider = new
CustomTableItemProvider(CMSContext.Currentuser);
string customtablename = "customtable.custom";

DataClassInfo customTableClassIinfo =
DataClassInfoProvider.GetDataClass(customtabTlename);

if (customTableClassinfo == null)
throw new Exception("table does not exist.");
else

// Provide ID of item you want to edit

int itemid = 5;

// Get custom table item with given ID

CustomTableItem item = ctiProvider.GetItem(itemId,
customTableClassInfo.ClassName);

// Set value of the custom table item field

jtem.Setvalue("Name", "Frank Jones');

// Update 1item

item.Update(Q);

5. With Tables.aspx selected in the Solution Explorer press Start (Play) as shown in
the following screenshot.

WebProject - Microsoft

File Edit View Website Build Debug Team Data Tools Test Analyze Window Help
" BRI | | % 53 j’l| R R -_:LElﬂ Windows Phone 7 Emulator ||Z§ |NewsM‘u‘C v| | Bl
| (69 Install Web Components -} _ | =5 R az (/2 | =2 | D003 &l 3 o 3 G) -

MRl Tables.aspx.cs* X REHERE

4 General %2 Tables N
—lusing System;
using System.Collections.Generic;
using System.Ling;
using System.wWeb;
using System.Web.UI;
using System.Web.UI.WebControls;
// added
using CMS.SettingsProvider;
using CMS.SiteProvider;
using CMS.DataEngine;
using CM5.CMSHelper;

There are no usable controls in
this group. Drag an item onto
this text to add it to the toolbox.

G B W R

=
@ W0 00~

63



Kentico Hands on Lab

6. Inthe running application click the Edit item button as shown in the following
screenshot.

@ & hitp://localhost1469/KenticoC 56, Tables.aspx

File Edit View Favorites Tools Help
1 v [ g v Pagew Safetyw Teols~ @~ 22 W] 53

[ Create new item [ Edit item ]

7. Loginto CMS Desk then select the Tools tab and then select Custom tables as
shown in the following screenshot.

e Kentico
'I‘ CMS Desk Content My desk Administration E-commerce On-line marketing

= Polis | [ Custom tables 4 Forums [3] Message boards % 3

B o [ = - 5§ %

Forms Media #@ Staging [y File import Blogs fa Groups @ Abuse report Projects  Events
Content Community Collaboration

8. Inthe Custom tables menu select the Edit (Pencil) icon for the Customer Contacts
table as shown in the following screenshot.

@ Custom tables

= Actions  Display name =

V4 Customer Contacts

P4 Sample table
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9. Inthe Custom table properties validate that the Name field contains Frank Jones
as shown in the following screenshot.

@ Custom table properties

» Custom tables » Customer Contacts

|_T§], New item tﬁ Select displayed fields

~ Actions ftemlD  Name Title Email Created by
FRRETI > |1 Joe Brown President joe@company.com Glebal Administrator (administrator)
FREQT S~ |2 Ted Thomas  Markefing VP ted@company.com Global Adminisirator (administrator)
| AR 4TI~ |3 Frank Jones  Dishwasher  thomasr@kentico.com  Global Administrator (administrator)
Summary

In this set of Hands on Labs we looked at how to create a custom table and then display
the data using the Basic Repeater web part. We also looked at how we can edit the
default transformation and use the Kentico CMS API. Specifically, we covered the
following.

e (Creating a custom table

e Adding data to a custom data using CMS Site manager
e (Creating a new CMS page

e Using Data source web parts

e Displaying data with the Basic repeater web part

e Editing the default transformation

e Adding items using the API

e Editing items using the API

Key Resources:

e http://devnet.kentico.com/Documentation.aspx

e http://devnet.kentico.com/Videos/Content-Management/How-To--Using-Data-

Source-Web-Parts.aspx
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Hands on Lab 3-0:
Required Changes in Twitter feed weh part

System Requirements:

e Kentico CMS 7 with the Sample Corporate Site
e Active Twitter account

Intended Lab Audience:

e CMS Developers

Lab introduction

The Twitter feed web part in Kentico CMS 7 uses the Twitter APl 1.0. This API has
officially been retired and replaced with a newer version. This change will cause the
Twitter feed Web part to stop working correctly. In completing this set of labs we will
look at how you can update your system to the newer Twitter web parts. In completing
this set of labs you will perform the following tasks:

e Update your system to the latest hotfix
e Import the updated web parts
e Retrieve the Widget URL from Twitter

‘e
>
This lab is not for production environments

This lab is not designed to be used on any production system. It always recommended
that you test and backup any environment before performing any type of system
upgrade.
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Lah 3-0-1: Undate to the latest hotfix

1. On your local machine click the Start button, and then click the All Programs
button as shown in the following screenshot.

I: All Programs '
Ay

2. Inthe program list expand Kentico CMS 7.0, then expand the Utilities folder, then
select the Kentico Installation Manager 7 (KIM) application as shown in the
following screenshot.

Intel PROSet Wireless - !
iTunes

Java ThomR
Kentico CMS 7.0

== Kentico Installer 7 Documents
£ Uninstall Kentico CMS 7

. Development Pictures

ation

Music

o Utilities
Kentico AD Import Utility 7

Computer
=t7 Kentico Installation Manager 7 (KIM
Kentico Service Manager 7

Control Panel

e

Logitech
ogrtec Devices and Printers

Maintenance
Microsoft Expression
Microsoft Office
Microsoft Office 2013 Help and Support
Microsoft Office Live Meeting 2007

Microsoft Sitverlight -

4  Back

Search programs and files 02 | Lm .

Default Programs
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3. Inthe Kentico Installation Manager 7 select the instance and then click the
Upgrade/Hotfix button as shown in the following screenshot.

ﬁ-I(er'ﬂ]cnInstaIIatlor.‘l_mlnll'lanagerI'r - dd a waid . -e .. -

]

-\ .'- Kentico Installation Manager 7 ol y I-'-.!.;M.!,t

q R
— Py -
‘ (@] ot ‘ e = H & v | c @ @ ‘ v

Browse Manage Edit Install Uninstall Deploy pgrade/Hotfix | Check Register  Unregister Services Settings

Find:

Name ~ URL Version Hotfix Registered Path

MNew upgrade (6.0->7.0) and hotfix {7.0.65) is available.

4. Inthe Upgrade/hotfix window in the Hotfixes node expand the 7.0 node and
then click the latest hotfix 7.0.65 (you may see different numbers) and the click
the Apply button as shown in the following screenshot.

3= Hotfix/upgrade — —— L=
Ny alimi
-0 Upgrade/hotfix unlimi I'-I—wl-:smu \I!it
'.\ i sibitics
Available updates Projects to be updated
= Hotfixes | Name URL Version Dowrloaded
&-7.0 =
L7080 localhost hitp:/localhost/kerticoams? | 7.0 No
7061
i-7.0.62
{7063

[

Update description

>

Custom tables - Changing the order of custom table data didn't change the order displayed by custom table listing web parts if ‘Cache
dependencies’ were set.

E-commerce - Documents with assigned SKUs weren't restored from the Recycle bin correctly.

Wedia library - The version history of media files wasn't deleted after removing a media library (because of a missing stored procedure),

Social networking - When a Twitter Autopost' form control was present on a form, but was not displayed due to a visibility condition or setting, a
JavaScript error occurred.

Translation services - Using a translation service to translate attachments of documents under workflow created duplicates of the attachments due to
incorrect GUIDs.

Widagets - An error occurred when working with widget properties that used the ‘Uni selector form control

-
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Do you have the latest hotfix?

Depending on the hotfix you have installed you may see different hotfix numbers
available.

5. Inthe Confirmation dialog select Yes as shown in the following screenshot.

Confirmation

P
[ 1
‘&Y' download them now?

Yes Ne

5 Some files (upgrade or hotfix) need to be downloaded. Do you want to

g

This lab is not for production environments

This lab is not designed to be used on any production system. It always recommended
that you test and backup any environment before performing any type of system
upgrade.
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6. Inthe Copying files dialog select Next when highlighted.

) aliasl
-‘ .‘- Copying files uniimi nl-!s!:m

7S

[ Show emor messages only

All operations have been successfully finished -
S0L script applied |] |
Running SQL script {Hotfix_default sql)

S0L script applied

Running SQL script {Hotfix_resource Strings.sql)
SCL script applied |
| Running SQL script (Hotfix_separated sql)
DLLs\natds

| CMS_PROJ

[l CMS5_PROJCMSWebParts
CMS5_PROJNCMSWebParts'\Widgets
CMS_PRONCMSWebParts\Viewers
CM5_PROJNCMSWebParts\Viewers\Query
| CM5_PROJMNCMSWebParts'\Viewers'\Basic

[ Fl 3

7. Inthe Finish dialog select Close as shown in the following screenshot.

p
ale . — =
=3¢ Kentico Hotfix Utility —mai=k

] nlimi
-:::- Finish unlimiy nl—wl-sm

« Selected actions have been succesfully applied.

Open logfile
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8. Inthe Kentico Installation Manager 7 screen validate that the selected instance
has the latest hotfix as shown in the following screenshot.

‘,?!- Kentico Installation l\-l'lanager‘_alr —n

\.' - - . m .
m=®w Kentico Installation Manager 7 unlimis . I'I"!sslbll tl!st
'.\ ite|  siblities
Jiv-N
B 8 © | & = & | A o | © @ | & | L
Browse Manage Edit Install Uninstall Deploy Upgrade/Hotfix Check Register  Unregister Services Settings
Find:
Name ~ URL Version offix | istered Path
localhost hitp:/Aocalhost kentico... | 7.0 65 0/31/2013 6:51:30 ... | C:hinetpubwwwroot W KenticoCMS7

MNew upgrade (6.0->7.0) and hotfix (7.0.65) is available.

—— — T —————_—— _— —

({4

Do you have the latest hotfix?

Depending on the hotfix you have installed you may see different hotfix numbers
available.
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Lah 3-0-2: Importing the Twitter weh parts

1. As Administrator log into Site Manager and click the Import site or objects as
shown in the following screenshot.

e Kentico

1% Site Manager Administration Settings  Development  Tools  Dashboard Licenses

&) Sites

o ¥
€ New site wizard | | |2} Import site or objects ~ |£ Export objects

~ Actions Site name «

Z%8 Y@l MW & Corporate Site

2. Inthe Import site screen in the Import packages list select the Twitter feed web
part package for you system type and then click Next as shown in the following
screenshot

(&) import Site

» Sites » Import site

Import type

StEP 1 Please select package to be imported and type of the import

Import packages:
[ Upload package 3§ Delete package @ Refresh
FacebooklLikeBox_WebPart_WebApplication.zip -

FacebooklikeBox_WebPart_WebSiteProjectzip

@ Preselect all items

) Preselect only new items

I
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Which package do | pick?

The Twitter web part feed packages are based on the type of Kentico installation you
performed. If you have a Web site project select the
TwitterFeed_WebPart_WebSiteProject.zip, otherwise as a Web application project select
TwitterFeed_WebPart_WebApplicationProject.zip.

3. In Step 3 expand the Development tab and select the Web parts node, in the Web
part list select the Twitter feed web part and then select Next as shown in the
following screenshot.

Objects selection

Step 3 Please select objects which should be imported.

&# Web parts (7]
- [ Global objects

Please note: You are about to import package from older hotfix version. This package includes versions of files for
Development
< web parts these objects which may not be compatible with the new hotfix version. All items which are in conflict with existing
p items were automatically deselected. Please select carefully items which you want to be imported.

Please select the objects to import. Existing objects are marked with * and will be overwritten if checked.

| Mone Default

Import Display name

- " Twitter feed

“Tiems per page: | 10

[
|
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4. In Step 4 with the import successful select Finish as shown in the following
screenshot.

Import progress

Step 4 Objects are being imported.

Import has successfully finished
Processing additional actions
Importing Web parts

Importing Web part categories
Preparing import process

Objects are being imported g
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Lah 3-0-3: Importing the Twitter weh parts

1. Loginto your Twitter account select the Gear icon and then select Settings as
shown in the following screenshot.

£ Home (oD Connect H

» trobbins
Twitter is better with friends! Edit profile
Import your contacts from thomrobbins@gmail.con

Twitter.

ﬂ trobbins

17,048

Help
Keyboard shortcuts

Tweets Twitter Ads

] axelkoster @ txelKoster - B
Shangri-La breaks ground for second hg =190 out r~

#| eadership #Social #AxelHappy #marketing #Travel ow Iy/rEj77
Expand

Who to follow - Refresh - View all

Inside Sales.com {:} InsideSales
Followed by Lucky-Fish and others
W Follow Promoted
ﬁ TLC @TLC_edu
¥ Follow

Panteli Tritchew @ FantzliT

AE- It halhe 0 bbmvmoar moore fricvmnee lod Aovmese t coemoeienoe

-
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2. Inthe left pane select Widgets, and then in the Widgets panel click Create new as
shown in the following screenshot.

£y Home (oD connect 4

Widgets

o

Create and manage your widgets

ﬂ trobbins
View my profile page

Account

You currently have no widg

Security and privacy
Password

Mobile

Email notifications
Profile

Design

Apps

|Widgets | >
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3. Inthe Create a user widget screen click the Create widget button as shown in the
following screenshot.

Search Q B 2% . =

— Back to widget settings

Choose a timeline source

User timeline Favorites List Search Custom timeline

Configuration Preview
Username @ | trobbins Tweets 7 Follow
Options Exclude replies & trobbins @trobbins ah i
Auto-expand photos ﬁ Digital Marketing University - Kentico Quick Guide H
-Writing an Effective Call to Action (CTA) bit.ly/1hKeWxF
Height Default (600p:
[, &9 trobbins @trobbins 5h
Theme Light |Z| ﬁ Marketing Automation on CMS Connected!
goo.glffb/nPDI7
Expand
Link color | Default (blue
For advanced visual options nlease refert @@, trobbins @irobbins 5h
the customization documentation. ﬁ Webinar: Kentico/Quesitonmine — Making your videos
interactive! goo glfb/DIgPi
[T Opt-out of tailoring Twitter [?] Expand &

Tweet to @trobbins

Create widget | (&=

4. Copy the Widget’s ID from the Twitter URL as shown in the following screenshot.

https:/ftwitter.com/settings/widg Ffocus_textarea=18notice=WIDGET_CREATED c B" Google

sential Step-by-... =. MVC : The Official Mic... Broadcast your hango.. £ Personalization Overvi.. =4 Pages - Google Analyti.. | | New Folder =- ASP.NET MVC 4 Mobil...

® - 2

Wack to widget settings

Configuration Preview
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e

Why do I need this?

In order to comply with the user interface requirements for Twitter this ID is used
anywhere the Twitter feed web part is shown.

Summary

In this set of Hands on Labs we looked at how to update the Twitter feed web part to
the latest API. This lab was meant for demonstration and it is always recommended that
you follow proper upgrade procedures on any Kentico installation. Specifically, we
covered the following.

e Update to the latest hotfix
e Importing the updated Twitter feed web parts
e Retrieving the Twitter Widget ID

Key Resources:

e http://devnet.kentico.com/Blogs/Juraj-Hrinik/May-2013/Changes-in-twitter-
feed-web-part-in-Kentico-CMS.aspx
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Hands on Lah 3:
Integrating Twitter with Kentico CMS

Lah Overview

System Requirements:

e Kentico CMS 7 installed with the Sample Corporate Site
e Completion of Hands on Lab 3-0: Required Changes in Twitter feed web part
e Active Twitter account

Intended Lab Audience:

e Content Administrators
e CMS Designers

Lah Introduction

Technically, Twitter is a micro blogging platform that limits real time comments (tweets)
to 140 characters. What may seem like a simple technology has become a worldwide
phenomenon with a projected 200 million active users. Leveraging this platform many
companies are looking to Twitter as a key part of their integrated marketing campaigns
and a key source of real time customer connections. With an extensive and well
documented API, Twitter looks to make site integration as easy as possible. In this lab,
we will add Twitter functionality to the Kentico Corporate sample site. This will enable
site users to tweet and engage about the things they find on your site and enable site
owners and administrators to extend their reach. In completing this set of labs you will
perform the following tasks:

e Add the Twitter feed web part

o Add the Twitter follow button web part
e Add the Twitter tweet button web part
e Update the Home page template
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Lah 3-1: Twitter feed weh part

1. Loginto CMS Desk as Administrator, in the Content tree select the Home page,
and then select the Design tab as shown in the following screenshot.

Content My desk  Tools Administration E-commerce On-line marketing

2 [ 0o v NN g 2

New  Delete o Move b Down Edit Preview  Live site List Search
Content management View mode Other
& ) Corporate Site® Page I Design I Form Properties  Analytics
o
D Home J Sign in to CMS Desk. Sign in to
|] Products
[ News®
3 partners® IT Company
|] Community®

2. Inthe web part toolbar with All web parts selected enter Twitter, then click the
Search (magnify) button as shown in the following screenshot.

| All web parts EAR™:
Twitter | PP

n Twitter feed

[1' Twitter follow button

A

L1 Twitter tweet button

m
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3. From the Web part toolbar drag the Twitter feed web part into the Main zone

web part zone as shown in the following screenshot.

¥ | Actions zone

v | Widget actions | (&3

|v i Maobile redirection {}“g|

v ] Left zone o=

Ter
~ Main zane

| v | '] CorporateSite_RandomProducts
r

L |

4. Inthe Web part properties (Twitter feed) update the following fields and then

select Ok.
Tab Field Value
General Widget ID Value retrieved from HOL 3-
0-2
General User name Your company twitter name
General Number of tweets 3
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5. Inthe Design tab validate that you see the TwitterFeed web part as shown in the
following screenshot.

Kentico Hands on Lab

Page Design Farmn Properties Analytics

- Actions zone

= Widget actions

Mobile redirection {3

+ W] Left zone

i

* Main zone

+ | '¥] Random products {3
Featured product

]

Price $21 99.00

& NewsletterSubscription | {3

w Newsletter

First Name

Last Mame

E-mail

- | TwitterFeed

m trobbins

goo.

‘I’tu'EquF‘|
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Lah 3-2: Twitter follow hutton weh part

1. Loginto CMS Desk as Administrator, in the Content tree select the Home page,
and then select the Design tab as shown in the following screenshot.

Content My desk  Tools Administration E-commerce On-line marketing

2 [ 0o v NN g 2

New  Delete o Move b Down Edit Preview  Live site List Search
Content management View mode Other
& ) Corporate Site® Page I Design I Form Properties  Analytics
o
D Home J Sign in to CMS Desk. Sign in to
|] Products
[ News®
3 partners® IT Company
|] Community®

2. Inthe web part toolbar with All web parts selected enter Twitter, then click the
Search (magnify) button as shown in the following screenshot.

| All web parts EAR™:
Twitter | PP

n Twitter feed

[1' Twitter follow button

A

L1 Twitter tweet button

m
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3. From the Web part toolbar drag the Twitter follow button web part into the Main
zone web part zone as shown in the following screenshot.

~  Actions zone o
~ Widgetactions &3
i |~ '¥]Rightzone o

~ (] Leftzone *‘ ~  Main zone

‘v ] CorporateSite_ScrollingNews (%

L1 Twitter follow button

[+ |'§] CorporateSite_RandomProducts 3]
-

Lo}

Apple iPad 2 In Stock

ive Steps to Online 06/08/2011 Today, we have good
acc oaranhicl: news for all fans of the awesome

4. Inthe Web part properties (Twitter follow button) update the following fields and
then select Ok.

Tab Field Value
General User to follow Your company twitter name
Design Display followers count Checked
Design Show screen name Checked
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5. Inthe Design tab validate that you see the TwitterFollowButton as shown in the

following screenshot.

|" Main zone

¥ TwitterFollowButton {3 llowers

v TwitterFeed

6. Inthe View mode panel select the Live site button, and then click the Follow
@trobbins button as shown in the following screenshot

2 [ el £ m L
Edit Preview Live site List Default ~ Search
View mode o Device Other
View | Validate
Last Name !
| 17K followers
E-mail .
Welcome to the sample Corporate Site
f won are new tn Kenticn CMS nlease read the followina infarmatinn hefore voin start exnloring th
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7. Validate that you receive a Twitter screen similar as shown in the following
screenshot.

\. y KenticoCMS Kentico CIS

- Kentico CMS is an gﬁoriﬂbff.: erb content
"‘ management solution for building Web sites,
community sites, intranets and on-line stores on the Microsoft
ASP.NET
http:/fwww kentico.com

Followers 1,344 Following 407
Ot RsEe-KE
Tweets
) KenticoCMS Kentico CMS
-'i‘- Learn the basics of Lead Scoring and how to get started bit ly/Pzgncm
#lentico #cms #oxm
about 7 hours ago Reply Retweet j‘_; Favorite
i ico CMS
2!,- KenticoCMS Kentico CI

#¢% New development teams in Kentico: Our company is growing together with
our product. | just want to... bit ly/PS0DjA #kentico #cms

about 11 hours ago

View @KenticoCMS's full profile —

Lah3-3: Twitter tweet button weh part

1. Loginto CMS Desk as Administrator, in the Content tree select the Home page,
and then select the Design tab as shown in the following screenshot.

Kentico
CMS Desk (@M Mydesk Tools  Administration  E-commerce  On-line marketing
i s = > "
\ ) il Co U o = —
s R 20 tw [q o
New  Delete & Move ) Down Edit Preview  Live site List Search
Content management View mode Other
&« -) Corporate Site® Page || Design I Form Properties  Analytics
[ Home" J = "
- ‘ Site Mana
"] Products
[ News®
[ partners®
| Community®
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2.
| All web parts =@ |
Twitter youl I

'_[ 5:‘ Twitter fead

L1 Twitter follow button

P

| ! Twitter tweet button

3.

~ | Actions zone

m

In the web part toolbar with All web parts selected enter Twitter, then click the
Search (magnify) button as shown in the following screenshot.

From the Web part toolbar drag the Twitter tweet button web part into the Main

zone web part zone as shown in the following screenshot.

| = ¥ CorporateSite_RandomProducts

= e
] L1 Twitter tweet butten |
&/ .

o}

-

!

~ TuitterFollowButton | & Tollowers|

~ TwitterFeed
K KenticoCMS
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= {1 Mobile redirection 3|
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‘v ] CorporateSite_ScrollingNews

Community Website Section
06/27/2011 As a result of our

continuous effort to improve our
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4. Inthe Web part properties (Twitter tweet button) update the following fields and
then select Ok
Tab Field Value
General Type Share a link
General Default tweet text You have to see this
General Via ourcompany
Share a link URL to share http://www.kentico.com

5. Inthe View mode panel click the Live site button, and then click the tweet button
as shown in the following screenshot.

¢ Kentico
s

S CMS Desk [N Mydesk Tools  Administration

mmerce On-line marketing
[ Copy 4 Up

, 4 [d AL
New Delete & Move { Down Edit Preview List Search
Content management View mode Other

&) Corporate Site* View | Validate
A -
[0 Products® { { {
[0 News
\j Partners”®
L} Community ® 3 Follow @kenticocms | 1,342 followers
Il Services _~ Featured product {70 Kentico CMS
[ company® e

il KenticoCMS
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6. Validate that you see the Twitter Share a link with your followers screen as shown
in the following screenshot.

W trobbins -

Share a link with your followers

You have to see this! hitp/www Kentico.com via @ourcompany

Tweet
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Lah 3-4: Undate the Home page template
1. Loginto CMS Site Manager as Administrator, select the Development tab, then click
Page templates, in the Page templates list then expand Corporate Site as shown in
the following screenshot.

Stes  Administration  Settings WVSGINIIS Tools Dashboard  Licenses  Suppert  Buy

Development = ﬁ Page templates
@ Countries
__ o
& €SS stylesheets ,i:;:‘ New template x Delete selected » Page templates » All page templates
@ cultures
3 New category Export selected Page templates | General
& Custom settings @ [B (
ﬁ Custom tables a Al e el A Display name: LIKE E
Device profiles & Ad-hoc || lsreusable: | Yes [~]
Document types — .
5 Articles [ show
<;t’5 Form controls ﬁ Blank
an
Inline controls .
. @) Blank pages for widgets ~ Actions  Display name = Is reusable
Javascript files S
ogs
Macro rules RS d = re 44 AB test example page template Yes
|l Corporate Site |
B Modules . 5 Examples # 3 = Administrator dashboard Yes
Notifications =l o .
E ) Mobile F R~ Adicle list with left menu Yes
[H Page layouts i ﬁ MVC 1
[ Page templates H P, o cin nevioin ol M R~ Aticle list with teasers Yes

2. Inthe Corporate Site page template list select the Corporate Site — Home page
template and then click the Design tab as shown in the following screenshot.

Page templates

/5] New template x Delete selected » Page templates » Corporate Site » Corporate Site - Home page

@ New category @ Export selected Generall Design |Sihes Scopes  Llayout Theme Webparts Header Documents  Versions
=/ LOrporate SIte - EVEnts i

=] Corporate Site - Events list H
Corporate Site - Events RSS _
Top content text
- Examples H L

Corporate Site
Corporate Site - Forum posts RSS
Corporate Site - Forum search

Corporate Site - Forum unsubscribe
—/ Corporate Site - Forums

-/ Corporate Site - Home page
Corporate Site - Image gallery
Corporate Site - Image gallery list

[ ravmacnbn O §anan aaan
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3. Inthe web part toolbar with All web parts selected enter Twitter, then click the
Search (magnify) button as shown in the following screenshot.

Al veb parts [+] @

Twitter | p

g Twitter feed

(-1 Tuiter follow button

[:;H Twitter tweet button

4. From the Web part toolbar drag the Twitter follow button web part into the Top
zone web part zone as shown in the following screenshot.

» Page templates » Corporate Site » Corporate Site - Home page

General | Design | Sites Scopes Layout Theme  Webparts Header Documents Versions
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5. Inthe Web part properties (Twitter follow button) update the following fields and
then select Ok.

Tab Field Value
General User to follow Kenticocms
Design Display followers count Checked
Design Shown screen name Checked
Design Size Large

6. Inthe upper right select the Sign out button as shown in the following
screenshot

Live Site CMS Desk A Global Administrator ¥ V/.0RC Q Sign Out

/ Enterprise Marketing Solution

7. On the Live site validate that you see the Follow @kenticocms as shown in the
following screenshot.

Signin to Signinto C : Manager. The default account is adminisirator with blank password.

O IT Company

Home Products News Community Services Company Media

> Home

o) Follow @kenticocms £ 1,343 followers

Discover Unlimited Website Possibilities!
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Summary

In this set of Hands on Labs we have looked at how we can add Twitter support using
both a Static text web part and page template. Specifically we covered the following.

e Add the Twitter feed web part

e Add the Twitter follow button web part
e Add the Twitter tweet button web part
e Update the Home page template

Key Resources:

e Feature Series: Twitter web parts

e http://twitter.com/about/resources
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Hands on lah 4:
Ul Personalization

Lah Overview

System Requirements:
e Kentico CMS 7 installed with the Sample Corporate Site
Intended Lab Audience:

e CMS Designers
e CMS Developers
e Content Administrators

Lab Introduction

Ul personalization enables the creation of simplified interfaces with CMS Desk. This will
decrease the learning curve, remove unnecessary features and enable users to focus on
areas of the system they really need. In completing this set of labs you will perform the
following tasks:

e Explore CMS Desk
e Add a new tab to CMS Desk
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Lab 4-1: Adding a new tah to CMS Desk

1. Loginto CMS Site Manager as Administrator, select the Development tab, then click
Modules and then click the Edit (Pencil) icon for CMS Desk as shown in the
following screenshot.

E Kentico

#IN Site Manager Sites  Administratio B Development
Development Ll; Modules
@ Countries
¢ CSS stylesheets (2 New module
@ Cultures
f Custom settings Module name: LIKE |Z|
ﬁ Custom tables Site name (all})

Device profiles
§ oevice » [ Show [

[l Document types
<% Form controls

+ Actions  Module name «
[Z3] Inline controls

Javascript files #® ~ | ABtesting

=] Macro rules R~ Abuse report
% Modules # 3 ~ | Administration
T Notifications

- Bad words
[B Page layouts 7R

@ Page templates 7R~ Badges
=8 Relationship names # ¥ ~ | BannedIPs
% Search engines 7R~ Banner management
System tables fx - Blo
as
& Tag groups H :
@ Time zones j 7R~ Categories
Translation services S ¥~ chat

2 Ut cultures @ ¥ | CWSDesk
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2. Inthe Modules screen switch to the User interface tab and then click the New

element button as shown in the following screenshot.

l-} Module properties

» Modules » CMS Desk

General  Permission names I User interface I Sites

[ Mew element | 4

= Ul elements

CMS Desk
Content
My desk
Tools
Administration
E-commerce
On-line marketing

Please select or create a UI element.

3. Inthe New element screen update the following fields and then select Save.

Field

Value

Display name

Kentico

Element is custom

Checked (True)

Caption

Go to Kentico

Target URL

http://www.kentico.com
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4. Validate that you see the updates as shown in the following screenshot.

E‘;ﬁiNew element 4 Up » Ulelements » Kentico
[EdDelete element [} Down General | Roles
CMS Desk H save
Content
My desk Display name: Kentico @
Tools Code name: Kentico @
Administration
Parent element: CMS Desk E

E-commerce

On-line marketing Element is custom:

Kentico
Menu item settings
Caption: Go to Kentico @
Target URL: http:/fwww kentico.com
Icon path:
Description: @
\
Size: @ Large () Regular

5. Loginto CMS Desk as Administrator click the Go to Kentico tab as shown in the
following screenshot.

Live Site ~ Site Manager

Content My desk Js  Admnstraton  E<ommerce  Ondine marketing | [[ECLNE)

B Contact our US Office v DevNet ClientPortal PartnerPortal Marketers o

)
-:::— Kentico

Product ~ Customers  Partners > Purchase  Support Training  Company

Kentico CMS for ASP.NET
unlimited website possibilities

Kentico CMS is the complete solution for your website. It helps you
easily create and manage corporate sites, on-line stores, intranets and
communities.

e RentcoToga T
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Summary

In this set of Hands on Labs we have looked at how to create Ul personalization.
Specifically we covered the following.

e Looked at Ul personalization
e Added a new tab to CMS Desk

Key Resources:

e Ul Personalization overview
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Hands on Lah 5:
Integrating Facehook with Kentico CMS

Lah Overview

System Requirements:

e Kentico CMS 7 installed with the Sample Corporate Site
e Active Facebook account

Intended Lab Audience:

e CMS Designers
e CMS Developers
e Content Administrators

Lah Introduction

Facebook has become an internet marketing sensation, with third party estimates of
almost 200 million users and reports that almost two thirds of these log in daily. For
many marketers, Facebook has become an essential ingredient for online and integrated
marketing campaigns. Facebook provides marketers and web site owner’s paid
advertising models that include user profiling, targeted advertisements, community
collaboration and networking opportunities. Non paid opportunities enable marketers
and web site owner’s the opportunity for their customers to discuss, share and
recommend content and products with their social network. Both provide an
opportunity for companies to build their brand, extend reach and collaborate with
customers. Facebook provides an extensive API that any website owner can leverage. In
this lab, we will add Facebook functionality to the Kentico Corporate sample site. In
completing this set of labs you will perform the following tasks:

e Add a Facebook recommendations web part
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Lah 3-1: Adding a Facehook Recommendations weh part

1. Loginto CMS Desk as Administrator, in the Content tree select the Home page,
and then select the Design tab as shown in the following screenshot.

M¢ Kentico

P18 OMS Desk [@LIC) M Mydesk Tools  Administration  E-commerce  On-line marketing
2 E 2w T (4 [d y
New  Delete | Move b Down Edit Preview  Live site List Search

Content management View mode Other

& -) Corporate Site® Page I Design I Form Properties  Analytics

o
D HOme J Sign in to CMS D Sign in to ¢
|] Products
[ News®
3 partners® IT Company
|] Community®

2. Inthe web part toolbar with All web parts selected enter Facebook, then click the
Search (magnify) button as shown in the following screenshot.

| All web parts [=] &

:

Facebook activity feed
Facebook comments
Facebook Connect logon
Facebook Connect required data B

Facebook facepile

LA

“E

Facebook like box

C

Facebook like button

m

Facebook recommendations

n- Facebook send button
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3. From the Web part toolbar drag the Facebook recomendations web part into the
Main zone web part zone as shown in the following screenshot.

= |Actions zone

= Widget actions 03

= '] Left zone ol ¥ Main zons op

+ 0] Random products i3

Featured product

1 n Facebook recommendations
i

|V Content te

Welicoi orporate Site

= If you are new to Kentico CMS, please read the following information before you start exploring the website:

=3

4. Inthe Web part properties (Facebook recommendations) update the following
fields and then select Ok.

Tab Field Value

Settings Doman http://www.kentico.com

o

Facebook recommendations web part

This will evaluate the current logged in user against the http.//www.kentico.com

domain.
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5. Inthe Design tab validate that you see the Facebook recomendations web part as
shown in the following screenshot.

¥ Main zone *

Web Decorum | Solution Partner | Kentico
#§% CMS for ASP.NET
5 people recommend this.

& Kentico CMS for ASP.NET | Best Web Content
Management System
15 people recommend this.

Free Edition | Kentico CMS for ASP.NET
1% One person recommends this.

E-commerce | Kentico CMS for ASP.NET
One person recommends this.

Content text :3|
b\lelcome to the sample Corporate Site

Summary

In this Hands on Lab we have looked at how to use the built in web parts included with
Kentico CMS. Specifically we covered the following.

e Identifying the Facebook web parts

e Implementing the Facebook recommendations button
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Lah Overview

System Requirements:

e Kentico CMS 7 installed with the Sample Corporate Site
e Active Twitter Account
e Active bit.ly account

Intended Lab Audience:

e CMS Designers
e CMS Developers
e Content Administrators

Lab Introduction

Social media has become an incredibly important part of any marketing campaign. The
problem is that using social media can take a lot of time. For marketers this is often a
luxury that is not available. Using a combination of social media integration and
Advanced workflow with Kentico you are able to auto post to your social media
accounts when a new document is published. In this lab we will create a new Advanced
workflow using the Kentico corporate site that auto posts to Twitter when a new blog
post is published. In completing this set of labs you will perform the following tasks.

e Understand what is needed to integrate Twitter and bit.ly with Kentico
e Setup social media integration with Kentico

e Create a new Advanced workflow

e Create a new workflow step that publishes to Twitter

o Set a workflow scope for blogs
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Lah 6-1: Create the Twitter application

1. Open a browser window and with your Twitter account log into
https://dev.twitter.com/apps and then select Create a new application as shown in the

following screenshot.

1@ My applications [Ty Topers -
File Edit View History Bookmarks Tools Help —

- o SR e &

c || B~ Google
W Developers AP| Health Blog Discussions Documentation Q '
Home
o .
My applications S

2. In the Create new application screen update the following fields and then click the
Create your Twitter application.

Field Value
Name Name of your website
Description Description of your website
Website URL of your website

3. Click the name of the application just created, then click the Setting tab, and in the
Application type section select Read and write as shown in the following screenshot and
then click the Update this Twitter application’s settings.
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Application Type

What type of access does your application need? Note: {@Anywhere applications reguire read & write access.
Find out more about our &Application Permiz=sion Model.

4. Select the Details tab and write down the Consumer key, Consumer secret, Access token,
Access token secret as shown in the following screenshot.

OAuth settings

Your application’s OAuth settings. Keep the "Consumer secret” a secret. This key should never be human-readable in your application.

Access level Read and write
About the application permission model

onsumer key

onsumer secret

Request token URL

Authorize URL

Access token URL

Callback URL

Sign in with Twitter

Your access token

Use the access token string as your "oauth_token” and the access token secret as your "oauth_token_secret” to sign requests with your own Twitter
account. Do not share your cauth_token_secret with anyone.

Access token

Access token secret

Access level

(g

Why write it down?
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This information will be used later in the lab as the basis for integration for Kentico.
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Lab 6-2: Collect your bit.ly information
1. Loginto bit.ly with your account, and in the dropdown select Settings as shown

in the following screenshot.

2. Inthe Settings screen select the Advanced tab as shown in the following

screenshot.

Settings

| IDENTITY = | PASSWORD SAVING . | CONNECTED ACCOUNTS  |FADVANCED {| | LABS |

3. At the bottom of the screen in the Legacy API Key section click the Show legacy
APl key as shown in the following screenshot.

Legacy API Key
If you already use a bitly API key to grant access to 3rd party applications, you can reset it here) Show legary APT ey

4. Write down the Login and API key as shown in the following screenshot.
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Why write it down?

This information will be used later in the lab for integration with Kentico.

Lah 6-3: Setup social media integration with Kentico CMS

1.

Log into Site Manager as Administrator, click the Settings tab, in the left pane tree view

expand the Social networks node and then click Twitter as shown in the following

screenshot.
0

Settings

Site: o Twi

witter

(global) €]

[Hsave | Reset these settings to default
Settings
° Content

=3 URLs and SEQ

& Security & Membership
. System

2 On-line marketing

B E-commerce

84 Community

| ¢ Social networks

i Facebook

o Intranet & Collaboration

g Versioning & Synchronization
9 Integration

< Cloud services

These settings are global, they can be overidden by individual website settings. Please select a site to see or change the site settings.

General
Consumersert 0

URL shortening

URL shortener @ sy [~

Export these settings
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2. Inthe Twitter tab update the following fields and then click Save.

Field Value
Consumer key CreatedinLab 1
Consumer secret Created in Lab 1
Access token Created inLab 1
Access token URL Created inLab 1
URL shortener Bit.ly

3. Inthe Social networks node select URL shortening as shown in the following screenshot.

X entico
#I% Site Manager Sites  Administration eSSt
e == URL shortening
(global) [=]
[Hsave | Reset these settings to default
Settings
@ content These settings are global, they can be overridden by indwidual website settings. Please select a site to see or change the stte settings.
=5 URLs and SEO
& Security & Membership bitly
& system
Login
= On-line marketing & e L 1}
TR E-commerce AP key Q| 1
&4 Community
Sﬂ Social networks
Facebook goo.gl
ﬁ Google+
[ LinkedIn APl ey 2]
Export these settings
o & Collaboration
<2 Versioning & Synchronization
9 Integration H
< Cloud services

4. In the URL shortening tab update the following fields and then select Save as shown
in the following screenshot.

Field Value

Login Created in Lab 2

API Key Created in Lab 2
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g

Why write it down?

This information will be used later in the lab for integration with Kentico.

Lah 6-4: Testing social media integration
1. Loginto CMS Desk select the Content tab, in the Content tree expand
Community, then Blogs and then Andrew Jones Blog as shown in the following
screenshot.

:!:; entico

#IN  CMS Desk Mydesk  Tools  Administration  E-commerce  ©n-ine marketing
B B @ Copy i Up . q [
Mew  Delete | Move &b Down Edit Preview  Live site List Default - Search
Content management View mode Device Other
{‘__’3 Corporate Site Page | Design Form  Properties  Analytics
D Home
D Products E Save Spell check
[ News
| Partners &l Source | B N | H & @ |
- [ cCommunity® Styles ~  Format - Font ~ Size » &~ A~ |
|} Blogs
Y] Andrew Jones Blog
T W March 2011° ’
October 2013
[] Events

2. Inthe Content management tab select New and then Blog Post as shown in the
following screenshot.

110



Kentico Hands on Lab

e Kentico
Fa

1 CMS Desk Content My desk  Tools Administration E-commerce Onine marketing
g jm How Tw 4| [d L
MNew |Delete = Move <} Down Edit Preview  Live site List Default -
Content management View mode Device
;_HEI Corporate Site 2 New document
D Home —
[ ] Products Please select new document type:
D MNews
) Partners [E] Blog month
[ community . Blog post
[ Blogs

'ﬁ:l Andrew Jones Blog
[E March 2011
[® october 2013
Events | A/B test page variant

Forums

&) Link an existing document

=
E

3. Inthe New blog post screen update the following fields and then select Save.

Field Value
Post title Test post — please ignore
Post summary Test post that we will send to twitter
Post text An example of using the integration with
twitter

4. At the bottom of the new blog post confirm that you see the Post at Twitter box
as shown in the following screenshot.
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Post at Twitter

Auto post at Twitter:

Tweet wasnt published yet 01140

5. Inthe Post at Twitter box update the following fields and then click Post at

Twitter.
Field Value
Auto post at Twitter Don’t forget to check out Kentico at
http://www.kentico.com

6. Confirm that you see the success message and then click the Tweet URL as
shown in the following screenshot.

Post at Twitter

Don‘t forget to check out Kentico at http://www.kentico.com

Auto post at Twitter.

591140 Pnsl at Twitier

I http./fwitter. comitrobbins/status/395342339788394496 |

7. Validate that you see the Tweet and the shortened URL as shown in the
following screenshot.

: * trobbins ' Follow
trobbins

Don't forget to check out Kentico at bit.ly
/1eNGbCr

4=~ Reply 3 Retweet Wy Favorite ¥ Buffer ees Laore

512PM-290ct13
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g

What am | looking at?

You have successfully tested the Twitter and URL shortening integration with Kentico.

1. Loginto Site Manager as Administrator, click the Development tab, in the left pane tree
view, click Workflows, and in the right pane, click New advanced workflow as shown in

the following screenshot.

Site Manager Sites Administration Settings Development Tools Dashboard Licenses Support
Development «| Workflow schemes
@ Countries —

d CSS stylesheets Workflows | Actions  Macro rules
fidl Custom tables e . e
& Device profiles 4 New workFlow I lew advanced worl ow'

[l Document types

L:_} Macro rules ~ Actions  Workflow hame ~ Type

‘H Modules /x v Default workflow Basic publishing

4] Notifications / x v Translation - Default language version Advanced publishing
[B Page layouts

ﬁ Page templates /x v Translation - Import to other language versions  Advanced publishing
ﬁ System tables /x W Versioning without workflow Basic versioning

i3} web part containers

& web parts

[@] Wweb templates

(] Widge

¥ Workflows

2. On the Workflow schemes page, in the Display name box, type Social_Post, and then
click Save as shown in the following screenshot.
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Workflow schemes

Workflows | Actions  Macro rules

¥ Workflows » Mew advanced workflow

Display name: SociaI_Pastg EI
12

oasname: [ 3uiomatc)

3. Click the Steps tab, and drag the Publish to Twitter step onto the design surface as
shown in the following screenshot.

Workflow schemes

J Workflows | Actions  Macro rules

» Workflows » Social_Post

General nil....' E-mails  Documents  Versions

(e % B 9] £ [ f 3 |=
3 Delste document  Delete document  Importtransiation  Link document  Move document  Publish to Facebook | Publish to Twitter  Bend e-mail €

Published  7''%X

e
I

Publish to Twitter '~ %

4. On the design surface in the Published step select the Edit (Pencil) icon as shown in
the following screenshot.
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Published AL X

R
I

Publish to Twitter "» X'

v)

5. Inthe Workflow step properties screen update the following fields, then select Save
and then click Close.

Section Field Value
Timeout settings Specific interval Selected
Timeout settings After 1 minute
Timeout settings Leave through Source point ‘timeout’

13

What am | looking at?
This will create a timer that will fire 1 minute after the document is published.

6. On the design surface for the Published step confirm that you see the timer icon and
blue connector as shown in the following screenshot.
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Published #

Publish to Twitter »# X

7. On the design surface for the Published step drag the blue connector to the Publish
to Twitter step as shown in the following screenshot.

EE=he==
_—

Publish to Twitter '/ X

4
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8. On the design surface for the Publish to Twitter step select the Edit step properties
(pencil) icon as shown in the following screenshot.

' Published ~ X

-‘F.JF
Y

Publish to Twitter » X
dit step properties

 J

9. Inthe Workflow step properties in the Action ‘Publish to Twitter’ parameters next
to Text select the triangle selector as shown in the following screenshot.
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:, Workflow step properties

» Steps » Publish to Twitter

General
E Save

General

Step type: Action
Display name: Fublish to Twitter

@S

Code name: PublishToTwitter

Action 'Publish to Twitter' parameters

Text: 3

10. In the Edit value text field enter the following macro and then select Save.

New Content Alert: {% DocumentName %} available at http://yourURL{%
Document.NodeAliasPath #%}.aspx

q

>

What am | looking at?

This macro is resolved when posted to Twitter and will include the document name and
shortened URL.
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11. In the Workflow step properties screen select Save and then Close as shown in the
following screenshot.

, Workflow step properties

¥ Steps » Publish to Twitter

General .

E Save 3

L3

General
Step type: Action
Display name: Publish to Twitter @
Code name: PublishToTwitter (2] E

Action 'Publish to Twitter' parameters

OMI New Content Alert: {% DeocumentNar

Text: 3 -

o=

12. In the Workflows menu select the Scope tab and then click New workflow scope as
shown in the following screenshot.
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1

« Workflow schemes

Workflows | Actions  Macro rules

» Workflows » Social_Post

General  Steps | Scope | E-mails Documents  Versions

Site: Corporate Site |E|

IlEE Mew workflow scope ! I

13. In the New scope screen in the General section in the Alias path click the Select
button as shown in the following screenshot.
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» Workflow scope » Mew scope

E Save

General

This scope covers: @ Specified document and its children
() Only specified document
(") Only child documents

Type: i@ Apply workflow on documents in this scope
(7 Exclude workflow from documents in this scope

Advanced

Crocument type: (all} |Z|
Culture: (all) (=]
Condition: j"“"]

14. In the Select path screen expand the Community node, then expand Blogs, select
Andrew Jones Blog and then click the Select button as shown in the following
screenshot.
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, Select path o x
Content ~
Site:| Corporate Site: [=] || Name: Search |
) Corporate Site || Actions  Name Type Size | Modified =
1) Home » () March 2011 Blog montn 6121/2011 8:57:38 AM
5 Products > ) October 2013 Blog month 1012412013 112812 AM |
News
B partners Items per page: | 10 ‘ -
] Community
General
[ Blogs il

¥] Andrew Jones Blog 5"

T TEVeN
) Forums
[ wiki

[ Services

[ Company

] Media

|| Examples

] Mobile®

] Other

< Special Pages

S

Selected path: [Community/Blogs/Andrew-Jones-Blog

[
,

15. In the Scope ID:1 screen update the following fields and then select Save.

Section Fields Value

General This scope covers Specified documents and its
children

General Type Apply workflow on
documents in this scope

Advanced Document type Blog Post (CMS.BlogPost)

173
What am | looking at?

In this example we created a workflow for blog posts only. You can have multiple scopes
that cover multiple different document types.
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Lah 6-6: Executed the advanced workflow

1. Loginto CMS Desk in the Content tree expand Community, then Blogs, select
Andrew Jones Blog and then click New as shown in the following screenshot.

Content My desk  Tools Administration E-commerce On-ine marketing

1= 3‘ [ copy i up q g

New | Delete /= Move  {F Down Edit Preview  Live site List Defaul
Content management View mode Devic
\;_j Corporate Site JE‘ Design  Form  Properties  Analytics
D Home
[ Products Hsave = spel check
D News
[ Partners &l Source | FERF R A
Community ™ i Styles ~  Format ~  Font ~ Size -
[ ] Blogs

Signinto

‘ﬂ Andrew Jones Blog

o | Qo

2. Inthe New document screen select Blog post as shown in the following
screenshot.
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| New document

Please select new document type:

[@! Blog month

I " Blog post I

zg}‘_ Link an existing document

ol A/B test page variant

3. Inthe New blog screen update the following fields and then select Save.

Field Value
Post Title I am trying out Kentico CMS Hands on Labs
Post date Select Now
Post Summary I am doing a lab in the Kentico CMS Hands

on Labs series

Post Text | am almost done and this is a test of the
social integration features.

4. Inthe New blog post screen click Publish as shown in the following screenshot.
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Page Design Form Properties Analytics

[ save | «f Publish ~ E spell check

Document is mr‘rer‘lﬂ!fusing Social_Post workflow and is in Edit step.

E| Source | By 8 G AC Ay | Hek o | B I U =
Styles v Format  ~ Font v Size v fA A~ | {# | R
Posttitle: | am trying out Kentico CMS Hands on Labs
Post date: 10/30/20133:0531 PM | & Now

vQ

What am | looking at?

This blog post is under the Social Post workflow we created in the previous lab.

5. Confirm that you see the workflow has moved to the Published step as shown in
the following screenshot.

Page  Design Form Properties Analytics

= Save _ Create new version x Reject - D Archive ¥

Document is currently using Secial_Post workflow and is in Published step.

—
=

Post title: | am trying out Kentico CMS Hands on Labs
Post date: 10/30/2013 3:05:31 PM E@ Now

I am doing a lab in the Kentico CMS Hands on Labs series
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6. Wait one minute and then refresh the document to confirm that the document

has been moved to the Publish to Twitter Step as shown in the following
screenshot.

Page Design Form Properties Analytics

k=i Save x Reject =

IDocument is currently using Secial_Post workflow and is in Publish to Twitter step, I

Posttitle: | am trying out Kentico CMS Hands on Labs

Post date: 10/30/2013 30531 PM | 5 Now

1 am domng a lab in the Kentico CMS Hands on Labs senes

7. Select the Live Site to confirm that you see the document as shown in the
following screenshot

I am trying out Kentico CMS Hands on Labs

| am doing a lab in the Kentico CMS Hands on Labs series

| am almost done and this is a test of the social integration features

| 10/30/2013 3:05:31 PM | 0 comments

\ —
Comments

Blog post currently doesn't have any comments

8. Open your Twitter account and verify that you see the Tweet as shown in the
following screenshot.

Tweets

_ % trobhbins 3
ﬁ New Content Alert: | am trying out Kentico CMS available at bit Iy
HMaally

L]
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Summary

In this Hands on Lab we have looked at how to use Advanced workflow to automatically
post to Twitter. Specifically we covered the following.

e What information is needed from Twitter to use social medial integration with
Kentico CMS

e What information is needed to from bit.ly to use URL shortening with Kentico
CMS

e How to create a new Advanced workflow

e How to create a scope that will select documents for an Advanced workflow

Key Resources:

e http://devnet.kentico.com/docs/devguide/index.html?workflow designing adv
anced.htm

e http://devnet.kentico.com/Videos/Feature-series/Kentico-Feature-Series-

Advanced-workflow.aspx
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Hands onlah 7.
Syndicating content with Issuu.com

Lah Overview

System Requirements:

e Kentico CMS 7 with the Sample Corporate Site
e Active account with Issuu.com

Intended Lab Audience:

e CMS Designers
e CMS Developers

Lab introduction

The traditional publishing industry has moved increasingly online. This move has created
a variety of self-service publish options across the internet. These sites are ideal for long
form content like white papers and e-books. Enabling a broader readership, additional
marketing opportunities and even extended analytics. In this lab we will publish a
document on Issuu.com and then syndicate the content to a Kentico site using the
flipbook option. In completing this set of labs you will perform the following tasks:

e Publish a document to issuu.com
e Create a blog post that syndicates the content

Lah 7-1: Publish the document

1. Loginto issuu.com and select the Upload button as shown in the following

screenshot
@ iSSUU Upload - Feed 0@
w.‘ r .‘ . . | i i LA m
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2. Drag the file you want published to the Select a file to get started section as
shown in the following screenshot

Publish to the biggest community of readers in the

3. Complete the Title and Description fields and then click Publish Now as shown in
the following screenshot
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Help your readers find
your publication

The Definitive Guide to the Cloud and Kentico Clv

Cloud computing is a broad industry term that
describes a wide range of services and
components.

11/24/2013

W This is a preview

M Readers can download

4. From the main menu select the My Publications menu option and then click the
uploaded document as shown in the following screenshot.

°&

==
Title
Popular
alesico [ xentico
0, 2 0, g
- -
S Kentico ves Kentico
The Definitive Guide to Kentico CMS 7 Hands on Kentico CMS Version 7 Guide to Web Testing
the Cloud and Kentico Labs (November 2013) Hands on Labs Using Kentico CMS 7s 7
CMS
alfxantce,

5. Inthe popup menu select the Share menu option as shown in the following

screenshot
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Share

Add to

Edit

See statistics

Distribute

Download

6. Inthe popup menu select Website or Blog menu option as shown in the following
screenshot

bl

Centi

‘ Bandy on L

Facebook
Twitter
Google+
Tumblr
LinkedIn

Email

Website or blog

Get link
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7. Inthe Design your widget page update the following fields and then select Save

style
Field Value
Size Click 525 X340 PX
Page layout Double
Autoflip the pages Selected
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8. Inthe Embed code dialog select the code as shown in the following screenshot

Embed code <div data-configid="5386789/5747654" style="width: 525px; height: 340px." class="issuuembed"=</div=<script type="text/javascript"
sre="//e.issuu.com/embed._js" async="trug"=</script=

Link issuu.com/ThomRobbins/docs/cloud_paper_v4?e=5386789/3747654
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Lah 7-2: Create the hlog post

5. As Administrator log into CMS Desk select the Content tab , in the Content tree
expand Community, then Blogs and select Andrew Jones Blog as shown in the
following screenshot

(ol Mydesk Tools  Administraton  E-commerce  Ondine marketing
-
(= (=) Co u = = =
5 RO ie BEN Qg @ 5 | B | P
New Delete = Move  <F Down Edit Preview  Live site List Default - Search
Content management View mode Device Other
I .
h_;j’ Corporate Site” Page | Design Form  Properties  Analytics
&) Download®
D Home ® ESaue 5|:|e|| check
[ Products”®
[ News® &l source | PR NG A & @ |
L] Partners”® E © v M | Styles -~ Format -  Font - 8z
= Commtm?tvl i
® Signinto C Sign in to CMS danager. The default account is
D Blogs
i] Andrew Jones Blog”
October 2013
[ Fvents®
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6. Inthe Content management toolbar select New as shown in the following
screenshot

¢ Kentico
Fy

1™ CMS Desk oyl My desk  Tools  Administration  E-commerce  Ondine marketing
2 3 Pow #w [d] =
MWew | Delete <k Move <} Down Edit Preview  Live site List Default - Search
Content management View mode Device Other
?’:_};3 Corporate Site ™ Page | Design Form  Properties  Analytics
&) Download®
D Home ® ESave Spell check
[ Products®
[ News"® El Source | PR S # @ | B
[l Partners*® El © v ¥ | Styles ~ Format ~  Font ~ Size
[ community *

. Sign in to CI: S Janager. The default account is a
= ] Blogs

= "] Andrew Jones Blog”
March 2011 ° O IT (gmpany

October 2013°
| ] Events”®

Home Products News
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7. Inthe New document screen select Blog post as shown in the following
screenshot

New document

Please select new document type:

i Blog month

Blog post

zip-‘_ Link an existing document

ol A/B test page variant

8. Inthe New blog post update the following fields

Field Value
Post title A new fantastic whitepaper!
Post Summary We have been working hard to provide you

the best content available. | am happy to
announce that we have completed a new
whitepaper. As always we would love to
hear your feedback.
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9. W.ith your cursor in the Post summary box in the WYSIWYG menu click the Source
button as shown in the following screenshot

E Save ﬁ Save and create anather E Spell check

" i

P A Bk @ | B I U = Xx x| ==
W (@] | Styes v Format  ~  Font v Size v A AT | {# | i

=] Source

Post summary:

10. Paste the issuu.com embed code from Lab 8-1 step 8 into the Post summary box
and then click Save as shown in the following screenshot

IlE Save ﬂ Save and create another 5 Spell chedk

El Source | |

Post summary:

<div WM="5386739!5747654" style="width: 525px; height: 340px:"™
class="issuuembed"></div><script type="text/javascript” src="//e.issuu.con/embed.js"
async="true "><,-"5cript>{
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11. Click the Live site button to view the document as shown in the following
screenshot

4 [d

Edit Preview
Wiew

View Validate

[ 04 FEE]

Click to read

ZiseeEIEEl EFEE

Qpen publication - Free publishing

Summary

In this set of Hands on Labs we looked at how to syndicate content using issuu.com and
then display the document using their autoflip feature. Specifically, we covered the
following.

e Upload the document to issuu.com
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e Copying the embed code
e Pasting the code into a Kentico CMS blog post

Key Resources:

e http://devnet.kentico.com/Documentation.aspx
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Hands on Lah 8:
Using Macros

Lah overview

System Requirements:
e Kentico CMS 7 with the Sample Corporate Site
Intended Lab Audience:

e CMS Designers
e CMS Developers

Lab Introduction

Macros are an important part of customizing Kentico. They provide an ideal way to
extend the system without having to write .NET code. In Kentico CMS, macro
expressions are strings in a special format, which consists of the expression itself and
two sequences of special characters that encapsulate it. When Kentico renders a page
that contains macros, it resolves the macros into their equivalent values based on the
current context. Kentico supports a variety of macro types:

e {% CurrentUser.UserName %} — context (data) macros
e {$404.info S} — localization macros

o {? nodeid ?} — querystring macros

o {@ StyleCookie @} — cookie macros

e {ABizFormControl A} —inline control macros

o {& /News/% &} — path macros

o {# mycustommacro #} — custom macros

o {~ mysubstitution ~} — substitution macros

In completing this set of labs you will perform the following tasks:

e Create an inline control macro
e Upload images for display using the inline control macro
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e Render the inline control macro on the live site

Lah 8-1: Adding an Editable Text weh part

1. Log into CMS Desk, click the Content tab, in the Content tree select the Home page,
click the Design tab, and in the Main zone select the Properties (+) plus sign as shown

in the following screenshot.

e Kentico
1N CM5S Desk My desk  Tools  Administraton  E-commerce  Ondine marketing

_.\." —-\," C - U' e e —

0 g Bow TH 4 [d] N

New  Delete = Move <} Down Edit Preview  Live site List Default - :
View mode Drevice

Content management

ﬂﬁ!l Corporate Site i orm  Properties  Analytics
) Download
Learn more
[ =]
E |
|| Partners
|| Community "’|Actiuns Zone
|| Services |v Widget actions %|
g Cam.pany w [ | Mobile redirection {33
|| Media =
] Examples v U] Left zone gp |~ Main zone
D Mohile® = E Random products @ |‘r TwitterFollowButton
3 other® ‘| ..~ Featured product v Contenttext 3

2. Inthe Select web part screen in the Web part name field enter Editable text then click
Search, select the Editable text web part and then click Ok as shown in the following
screenshot.
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#. Select web part

ﬂ Recently used web parts —
&) All web parts

) Abuse report

) Articles

& Attachments
Banner management

Web part named: Editable text

m

Blogs | &
Chat
Community

Editable text

Content rating
Custom tables
Data sources
Device profiles
Document library
E-commerce

Events & booking Editable text
Filters

Provides an editable text region that can be used to er
Users can edit the region in CMS Desk -> Content -> Et
editing mode. When saved, this content is displayed or

Forms
Forums
Full-text search

65 666666066600606060

3. Select the Page tab and validate the Editable text web part as shown in the following
screenshot.
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Page s5ign Form Properties Analytics

E Save Spell chedk [ Add widget Reset to default

o

E] Source | By B e AR ABC- | H e @ | B I U e X, x2 | = F

El © vr B | Styles * Format - Font v Size v A A~ | |

E-mail: @

: Clicking this button will take you to the Support - = APl e:
Subscribe J iview and execute examples of code utilizing Kentico CM

" ”

W

Lab 8-2: Adding an Inline Control Macro

1. On the Page tab In the Editable text web part enter the following inline control
macro and the click Save.

{rAttachmentimageGallery”}
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What am | looking at?

Macro expressions are string in a special format, for inline control macros these start
and end with the » character.

2. Validate that you see the inline macro as shown in the following screenshot.

Page Design Form Properties Analytics

E Save @ Spell check [ Add widget =[G Reset to default

E] Source | BY B8 (G ABC ABC- | Mo @ | B I U = X x2 | i= &

E] © vy M [8] | Styes ~ Format ~  Font v Size v A~ AT | {# |

-{*AttachmentimageGallery"}

3. Select the Properties tab, then click the Attachments tab and then select New
attachment as shown in the following screenshot.
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4 & L) A
Edit Preview Live site List Default = Search
Wiew mode Device Other

Page Design Form |P'ruperties Lnalytics

General | ':'ng. MNew attachment l

URLs 1 There are no atﬁchmentrs for the current document.
Template
Metadata
Cateqgories
Mavigation

Related docs

Linked docs

Security

What is an Attachment?

Attachments are files added to a website document and bound to the document
lifecycle.
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4. Inthe Open dialog box, select a few images, and then click Open to upload them as
attachments of the document as shown in the following screenshot.

. Open . . .
@Ovl = ¢ Libraries » Pictures » My Pictures » v|¢f|| Search My Picture

Organize « Mew folder |
/¢ Favorites = Pu:t_ures library Arange by
Bl Desktop My Pictures
4 Downloads | e —— [T [P e—— i - . -
* Droob Kentico_EMS_log Kentico_EM5_log Kentico_Powered Keyboard
W Lfopho o_black_width120 o_width1200px By_Button_width
=l Recent Places Dpax 300px
%/ iCloud Photos | = 1 -
1 Libraries % 5 =

3 Documents

J’J Music

] Pictures =l Multi-irnage myce_bg Myco_grass myco_lego_no_b | -
= My Pictures ’
. Public Pictures
4 Photos (ATHO

™ videos

UN

- small -DhAU zocial Sociall

File name: "social” "Multi-image" "penguin” » | Allowed files

5. On the Attachments page, verify that the uploaded files appear in the list as shown in
the following screenshot.
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Page Design Form Properties Analytics

General |4 Mew attachment
o l + Actions Update Name
Template e 48 E'SIE 3 |=| Multi-image.ipg
Metadata re 48 X' 3= 3 =/ penauin.jpg
g re 1K '3E 3 =/ social JPG
MNavigation

1 Related docs

- Linked docs
Security
Attachments %

6. Select Live site as shown in the following screenshot.

148



Kentico Hands on Lab

N P

W.

Edit Default = Search
Dievice Other
Page Design Form Properties Analytics

General _nq- Mew attachment
LRL

. + Actions Update Hame
Template re 48 '3E Y = Multi-image.jpg
Metadata 8 &8¢ 1 # | = penquinipg
s re 4k NE! Y =] social JPG
Mavigation

7. Select the Live site and validate that you see the images as shown in the following
screenshot.
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List

[
Edit Preview
Wiew

N pf

Default - Search
Device Other

View Validate

The Examples section of this website contains live exam
home page customizable by individual users using widge

APl Examples

Clicking this button will take you to the Support - = APl ex
view and execute examples of code utilizing Kentico CM:

8. Click one of the uploaded images and verify that the control displays them in a light

box, as shown in the following screenshot.
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(4 [d = N Y
Edit Preview Live site List Default ~ Search
View mode ‘ Device Other

f | view | Vvalidate

penguin.jpg
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In this set of Hands on Labs we looked at how to use macros with Kentico. Specifically,
we covered the following.

e Using aninline control macro
Key Resources:

e http://devnet.kentico.com/docs/devguide/types of macros.htm?zoom highlig

htsub=macro
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Lah overview

System Requirements:
e Kentico CMS 7 with the Sample Corporate Site
Intended Lab Audience:

e CMS Designers
e CMS Developers

Lah introduction

Landing pages are designed with the purpose of capturing information for follow up. As
a general rule it is important to try and keep the content to a minimum with the goal of
obtaining a visitor’s email address, and avoiding additional information that could
distract from the user clicking away to a different website. Many times you may want to
entirely remove all navigation and hyperlinks. The absence of links is used to focus the
visitor’s attention on one choice: register for the offer or leave the site. Landing pages
are often used with an auto responder to begin delivering information as soon as the
visitor confirms their email address. The auto responder may be utilized to send a
follow-up email or to provide an immediate download link to get information. Kentico
CMS provides the ability to create an online form that provides an auto-responder. In
this lab we will create a landing page that a user can provide their email information in
return for an email that contains a whitepaper link. In completing this set of labs you will
perform the following tasks:

e Create a landing page
e Create an online form
e Create a follow up email for the completed email
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Lab 9-1: Upload the whitepaper

9. Loginto CMS Desk select the Content tab , in the Content tree select Corporate
site and then select the New button as shown in the following screenshot.

& Kentico
- -
#IN  CMS Desk Mydesk  Tools  Administraton  E-commerce  Ondine marketing

=1 e Cu‘ U ' B 1 =

B Eicomw Tuw 4 [d ) P
MNew Delete | = Move 4 Down Edit Preview Live site List Default - Search
View mode Device Other

S Content management

& Corporate Site Page | Design Form  Master page  Properties  Analytics
| ] Home®™ .

Products =2 Spell check

News Sign in to ¢ Signinto C e Manager. The default account is admi
Partners

Community Corporate site logo

Services

Company \’, N LU’"Ipany

Media Home Products News Community Servic
Examples

Mobile*
Other

Special Pages
i) Images

-

O DWW W ) W mw

10. In the New document screen select Folder as shown in the following screenshot.

: New document

Please select new document type:

[] Page (menu item])
B Wireframe

Y] Blog
5 Eolder

%] Link an existing document
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11. In the New folder screen in the Document name field enter Download and then
select Save as shown in the following screenshot.

(4 [q =Y o
Edit Preview Live site List Default - Search
View mode

Dievice Other

E Save ﬂ Save and create another Spell check

Document name: Download

12. In the Content management panel click New as shown in the following
screenshot.

:.'.:. entico

1

CMS Desk Content [T S T Administration ~ E-commerce On-ine marketing

; [ copy i Up ] 4 lg p

Delete [» Move ) Down Edit Preview  Live site List Default - Search
Content management View mode Device Other

& ) Corporate Site
) Download
[ ] Home Hsave [ spell check
D Products
[ News Documentname:  Daownload
D Partners
[ community

Page Design Farm Master page Properties Analytics
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13. In the New document screen select File as shown in the following screenshot.

| New document

Please select new document type:

[ ] Page (menu item)

) Folder

%] Link an existing document

o A/B test page variant

14. In the New file screen click the Upload file, from your local drive select the

campaign whitepaper, and then select Save as shown in the following
screenshot.

ﬁ Save and create another % Spell chedk

Upload file: 4 Upload file

File description:
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15. In the campaign whitepaper screen select Properties and then verify that you see
the Live URL as shown in the following screenshot

I_(e_ntico
CMS Desk Content My desk Tools Administration E-commerce 0OnHine marketing
Co u e Y —
2 B Fow tu L4 | [d N
New Delete = Move < Down Edit Preview  Live site List Default - Search
Content management View mode Device Other
!"_’3 Corporate Site Page Form  Master page“ Properties m.ﬂnalyﬁcs
& Download — |
== Understanding-The-ROI-of-M Hsave
_I_]. Heme General > Mode GUID 8723771-6632-404d-2194-f3b27106de 11
9 Products Document GUID 19¢15300-653b-4c70-99be-8dbba5471a56
|1 News S Alias path IDownloadUnderstanding-The-ROl-of-Marketing-Automation
|| Partners Template Culture: English - United States
D Community " 2 = | L oo i T o DU ef laslodio o "
D Services Metadata | Live URL: !KenticoCMS'HDownloadJ'Understandinq—The—RDI—of—Market\nq—Aulomation.asgxI‘
D Company 2 . f
[ Media - Published: Yes
D Examples Mavigation
e S H Owner
_I—J Mobile W Related docs
|| other [l Owner. G\oba\Administrator(administratcmm
) Special Pages Linked docs Owned by group:
el
Y Images Serurity

g

>

What am | looking at?

This is the URL that is used to access the whitepaper. Later in the response email this URL
will be embedded.
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Lah 9-2: Create the custom tahle and autoresponder

1.
the following screenshot.

Me Kentico |

I CMS Desk

Administration

Log into CMS Desk, select the Tools tab and then click Add a new form as shown in

E-commerce On-line marketing

@ R

% ’E E Polls (75 Translations [} Custom tables % chat ﬁ Message boards |§] 'F‘d_'u @
Forms  Media  [f5) Banners B Staging [y File import Biogs  Forums  fla Groups ‘g Abuse report Projects  Events Newsletters (g W
Content Community Collaboration Marketing & R
% Ecti)drms |'ﬁ File import
a new form Import files from your computer
Import files from server disk
| Media
w Add a new media library Blogs
View comments waiting for approval
e Paolls View blogs
Add a new pol
s"* Forums
[F=] Banners Add a new forum group
Add a new banner category
@@= Chat
2. Inthe New form screen in the Form display name enter White Paper Campaign and

then select Save as shown in the following screenshot.

I Form dizplay name: White Paper Campaign I

Form code' name: | [automatic)

Table name;

@

Form_CorporateSite_ (automatic)
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3. In the White Paper Campaign form update the following fields and then select

Save.
Section Field Value
Form settings Redirect to URL http://www.kentico.com
Form settings Submit button text Get the paper!

4. In the Form properties screen select the Fields tab and then click the New attribute

button as shown in the following screenshot.

Form Properties

» Forms » White Paper Campaiagn

Data  General || Fields |} Form  Motification e-mail  Autoresponder  Security  Altermative forms  Ondine marketing

Versions

WhitePaperCampaignlD* BB ﬁ E Save T Switch to advanced mode

Forminserted®

FormUpdated® @ Simple mode
Column name: WhitePaperCampaignlD
Q Show on public form: ]
Field caption: WhitePaperCampaignlD
Field type: Label

Allow empty value:

Default value:

R
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5. Inthe New attribute screen update the following fields and then select Save.

Section

Field

Value

Simple mode

Column name

EmailAddress

Simple mode

Field caption

Email

Simple mode

Field type

E-mail

6. Inthe Form properties screen select the Autoresponder tab and in the
Confirmation e-mail source field select Emailaddress as shown in the following

screenshot.

Form Properties

» Forms » White Paper Campaign

Data General Fields

E Save l,_ﬂ_q Attachments

Form  Motification e-mail | Autoresponder | Security  Altermative forms  Ondine marketing  Versions
I(-)unﬁrmatiun e-mail source field. EmailAddress : I

From e-mail:

Subject

Generate table layout

El Source | e &
B I U =8 X, x2 | = = | @
Styles ~ Format ~ Font ~ Size w
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7. Inthe Autoresponder tab update the following fields

Field Value
From e-mail Company@company.com
Subject Here is your whitepaper

8. Inthe Message field enter the text as shown in the following screenshot.

Generate table layout

. Available fields:
El source | B m | « B a| =2 =] WhitePaperCampaigiis
B I U = X, x2 | = = z | & PleB = o) Ecr:r:?r::'r?sdgr‘[zzs
Styles -  Format - Font v Size v fAuv AT | ) | 2l FomUpdated

Thanks for your interest in our new whitepaper!

You can access your whitepaper using the following link
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9. Inthe Message field select the word link and in the WYSIWYG editor click the
Insert/ Edit link (World icon) as shown in the following screenshot.

Generate table layout

El source | of By @ @ @ | &
B I U == X, x* | = i E | FFJIEIEI—QI

Styles ~ Format ~ Font

£
LN
(i
[
1]
Il

4
L
[
b

L
T

4
=

4
——
]

Thanks for your interest in our new whitepaper!

You can access your whitepaper using the followin

10. In the Insert link screen select the Content tab, expand the Download, then select
the Whitepaper link and then click Insert as shown in the following screenshot.

3 nsertlink

I Media libraries  Web  Anchor  E-mail -
@ MNew folder I—l New file Tiles Thumbnails IE|

: ;
Site: | Corporate Site |Z| —~

General Target Advanced

{;':; Corporate Site —
— = Frotocol: URL:
& Download \»

: http:/f |Z| localhost/KenticoCMS7/Download/Understanding-The-ROl-of-Marketing-Automation
2 Understanding-The-R(

[ Products N
D News
[] Partners L4
[ community

|1 services

D Company

| ] Media

ﬂ"!ExamDIes x
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11. In the Message field validate that you see the completed email and then click
Save as shown in the following screenshot.

E Save l'ﬁ_j Attachments

SUTTEn 0N e-mall source feld: | EmailAddress [=]
From e-mail: Company@company.com
Subject: Here is your whitepaper

Generate table layout

o Available fields:

Blsowce | # HBEBE | « » B2 2| == =S| WhitePaperCampaigilh
B I U == X, X2 i= = PE = EmailAddress
- : | ' | &P | = O ) | Farminsered
Styles ~ Format -  Font v Size - T AT | {#} | FormUpdated

Thanks for your interest in our new whitepaper!

You can access your whitepaper using the following [

12. In the Form properties screen select the Data tab and then click the New record
button as shown in the following screenshot.

Form Properties

¥ Forms ¥» White Paper Campaign

I Data IGeneraI Fields Form  MNotification e-mail  Autoresponder  Security  Alternative forms  Ondine marketing  Versions

l@ Select displayed fields

Mo data found.
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13. In the New record screen in the E-mail field enter your email address and then
click save as shown in the following screenshot.

ey - —— ey

Form Properties

¥ Forms » White Paper Campaign

Data | General Fields Form  Motification e-mail  Autoresponder  Security  Altermative forms  Ondine marketing  Versions

» Data » MNew record

Send notification e-mail Send autoresponder e-mail

E Save

WhitePaperCampaigniD:
Email: 'myaddress@coi‘npany.com

14. Validate that you receive the email as shown in the following screenshot.
(52 Reply (2 Reply All (2 Forward
Wed 1/8/2014 4:53 PM

Thomas Robbins

Here is your whitepaper
To Thomas Robbins

Thanks for your interest in our new whitepaper!

You can access your whitepaper using the following link
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1. Loginto CMS Desk, select the Content tab, in the Content tree select the folder
Special Pages and then in the Content management menu select New as shown in
the following screenshot.

[Nyl Mydesk T Administration E On-ine marketing

N — Con = _

g Do T L4 | d y
MNew Delete | Move & Down Edit Preview  Live site List Default -
Device

P

Search
Other

Content management View mode

=
%) Corporate Site Page | Design Form  Masterpage  Properies  Analytics
) Download
D test E Save Spell check
D Home

D Products
D News Corporate site logo

8ignin to Signinto

[ Partners | Select 3§ Clear
[0 community
|1 services test Home Products
D Company
[ Media

D Examples
[ Mobile®

» Special Pages

Qb
1] Unsubscribe
|1 E-shop
D User
[ search
| Logon Page H
[] Rss
D Newsletter Approval
& Images

2. Inthe New document screen select Page (Menu item) as shown in the following
screenshot.

: New document

Please select new document type:

[] Page (menu item

e

) Folder

) Link an existing document
o A/B test page variant
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3. Inthe New page dialog in the Page name field enter Whitepaper, in the Template
name enter Corporate site — widget, click Search, select the Corporate Site — Widget
Page for Editors page and then click Save as shown in the following screenshot.

I E Save |ﬁ Save and create another

&y All page templates
) Articles

5 Blank

Blank pages for widgets

Blogs

Corporate Site

Events

FAQs

Forums

General

Home pages

Images

Job openings

Knowledge base

Master templates

Membership and security

News

Newsletter

Offices

Press releases

Products

YOLLLLLLLLLLOBBOODD

spell check

RELENEN R Whitepaper

@ Use existing page template () Use parent page template () Create a blank page with layout () Create a blank page

Corporate Site -
Widgets Page for
Editors

|

I-Temp\ate name: Corporate site - widget m |
—

Corporate Site -
Widgets Page for
Users

4. On the Whitepaper page click the Add widget button (+) as shown in the following

screenshot.

Page Design Form Properties

Analytics

E Save Spell check

nager. The default account is administrator with blank password.

Home Products News Community Services Company Media

Whitepaper
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5. Inthe Select widget dialog in the Widget name field enter Rich text, then click

Search, select the Rich text widget and then click Ok as shown in the following

screenshot.

Select widget

Qﬁj Recently used widgets
i all widgets

Banner management
Categories
Community

Content

Corporate Site
Dashboard
Document library
Forms & Surveys
Forums

General

Intranet Portal
Layouts

Maps

Media & services

Navigation

LoLLLOLLLLLDLELD

Newsletters

i

Widget name: Richtext [ |Search in description

Rich Text

The Rich text widget can be used to place HTML content onto the page. Users may utilize a WYSIWYG toolbar while editing the text, which
provides various additional formatting and content options.

6. Inthe Widget properties (Rich Text) screen update the following field.

Section

Field Value

Content

Text Download our new
whitepaper!

In this informative
whitepaper you will learn
how you can leverage our
software to increase the ROI
of your website. This 25
page guide provides
everything you need to get
started
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7. Inthe Widget properties (Rich Text) screen select the Download our new
whitepaper! text, in the WYSIWYG editor in the Format drop down select Heading
and then click Ok as shown in the following screenshot.

@' Widget properties (Rich Text)

B I |iZE | & | Fc-r.-f ~ Size v A A- N
Content
Download our new whitepaper!
In this informative whitepaper you will learn how you can leverage our software to
Text increase the ROl of your website. This 25 page guide provides everything you need to
get started g
body h1
Widget container
‘Widget container: (none) El m

‘Widget container fitle:

LR e
[ £

168



Kentico Hands on Lab

8. Onthe Whitepaper page click Add widget as shown in the following screenshot

Signinto < Signin to Cl lanager The default account is administrator with blank password.

test Home Products News Community Services Company Media

> cial Pages » Whitepaper

-+
E

Download our new whitepaper!

iIn this informative whitepaper you will learn how you can leverage our software to increase the ROl of your website. This 25 page guide provides everything you need to get started

9. Inthe Select widget screen in the Widget name field enter Columns, then select
the Columns layout widget and then select Ok as shown in the following
screenshot.

El Select widget

@ Recently used widgets B IIW‘dQEt name: [Columns I Search Search in description
) All widgets = s

Banner management

i

Categories
Community
Content

Corporate Site
Dashboard
Document library
Forms & Surveys
Forums

Columns layout

m

General
Intranet Portal

Layouts All widgets

Maps
Media & services

Navigation

VLB LERHEBELHEEBEEHE
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10. In the Widget properties (Columns layout) screen update the following fields and
then select Ok.

Section Field® Value

Layout settings Number of right columns 0

11. On the Whitepaper page resize the Columns layout to an equal width as shown
in the following screenshot.

» Special Pages » Whitepaper

4]

Download our new whitepaper!

1o thic informat hitonanaraon will loare boseaion oo layaraoo our coftears 4o incroace the DOV of vonc wabeita Thic 26 nooo avida oroid, pdhing aron nood to oof ctorad

98 Remove Iast left column o Add left column

a8

o Add right column

12. In the Columns layout widget on the left select the Add widget (+) button as
shown in the following screenshot.

» Special Pages ®» Whitepaper

o

Download our new whitepaper!

In this informative whitepaper you will leam how you can leverage our software to increase the ROl of your website. This 25 page guide provides everything you need to get started

FEEd

Add widget l left column fs Add left column

g Add right column
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13. In the Select widget screen in the folder list click the Recently used widgets folder,
then click the Rich text widget and then select Ok as shown in the following

screenshot.

F1 Select widaet

Widget name: m [15earch in description

&) Banner management bl

G Categories - -D-:.-'o: -D..:._.'.:

&) Community | =t. L=

i Content & — -

i Corporate Site 1

& Dashboard Attal:hmltlant image Columns layout On-line form Rich Text Static HTML 3

&) Document library gatlery

i Forms & Surveys

& Forums

“ General T L4
T

%) Intranet Portal o

=S —

) Layouts L=

& Maps y

&) Media & servicas

© Navigation

) Newsletters Rich Text

) Reporting The Rich text widget can be used to place HTML content onto the page. Users may utilize 3 WYSIWYG toolbar while editing the text, which provides

i) Syndication various additional formatting and content options.

&) Text

14. In the Widget properties (Rich Text) screen in the WYSIWYG menu select the
Insert/Edit image or media (Picture) icon as shown in the following screenshot.

@‘ Widget properties (Rich Text)

B I |[EE | & | Format -~ Font - Size = A AT i
| =
Insert/Edit image or media
Content
Text: 1
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15. In the Insert image or media screen select the Content tab, then in the Content
tree expand Media, then Image, then Logos, select Kentico and then click Insert as

shown in the following screenshot.

% insert image or media

Content | |Media lbraries  Web .

I
[=] Tites Thumbnails 7]

(
@ New folder I New file ‘

Ste: | Corporate Site B General | Link  Advanced  Behavior

P +|| URL /KenticoCM: i aspx [}
) Corporate Site -
- Alternate text
&) Download
= Understanding-The-r( || 19" 226 am
D test Height 162 .
] Home Border width: ‘ ' . &
= mew Kentico
[ Products Border color £’} '.‘
1) News Horizontal space
& Partners Vertical space
[ community Align tnane) = Lorem ipsum dolor sit amet, cansedtetur adipiscing elit. Pellentesque turpis lacus, convallis dignissim, consectetur vel,
\_] Services rutrum non, risus. Integer non risus et diam ultrices sollicitudin. Aliquam faucibus imperdiet massa. Vivamus eros. Cras eu dolor. Duis lacinia purus at massa.
o Praesent omare nis| ac odio. Integer eget metus. Sed portitor. Aliquam erat volutpat
B Media I
[ 1mages H

London Office
Logos

B Kentico

B Client Portal
[ Connection
i Trees for Bugs
[] videos
[ Examples
=N

172



Kentico Hands on Lab

16. In the Widget properties (Rich Text) select Ok as shown in the following

screenshot.

@' Widget properties (Rich Text)

-

B I |z & | & mal | rormat -~ Font ~ Size v B AT K

Content

m

W .
7‘:\- Kentico |

Text:

Refresh page
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17. In the Columns layout widget on the right select the Add widget (+) button as
shown in the following screenshot.

» Special Pages » Whitepaper

o

Download our new whitepaper!

In this informative whitepaper you will learn how you can leverage our software to increase the ROl of your website. This 25 page guide provides everything you need to get started

=
i

-:::- Kentico

$€ Remove last left column s Add left column s Add right column

18. In the Select widget screen in the Widget name field enter On-line, then click
Search, select the On-line form widget and then click Ok as shown in the following
screenshot.

(=] ele dge O

% Recently used widgets widget name: on-line i i Search in description
) All widgets I

Content @
Corporate Site

Dashboard On-line form On-line users

Banner management
Categories
Community

Document library

Forms & Surveys
Forums

General
Intranet Portal
Layouts

Maps

Media & services
Navigation .
Newsletters On-line form
Reporting The On-line form widget allows vou to insert your own on-line form on the page.
Syndication
Text

BoHE6LLLL000056066006088

S TR——
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19. In the Widget properties (On-line form) dialog in the BizForm Settings section for
the Form name field and then click Select as shown in the following screenshot.

@' Widget properties (On-line form)

BizForm settings

Form name*: Select Clear

Conversion tracking

Conversion value:

Widget container

20. In the Select forms screen click the White Paper Campaign as shown in the
following screenshot.

Select forms

Form name orits part: | m

Form name

Contact Us

White Paper Campaign

ltems per page: 10 |Z|
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21. In the Widget properties (On-line form) select Ok as shown in the following
screenshot.

@' Widget properties (On-line form)

*

BizForm settings

Form name™: WhitePaperCampaign mm

Conversion tracking

Conversion value;

m

Widget container

Widget container: (none) E m

Container title: 5

[7|Refresh page oK | “Cancer—[—ppl —
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22. On the Whitepaper page select Save as shown in the following screenshot.

Page | Desgn Form  FProperties Analytics

Home Products News Community Services Company Media

» Whitepaper

Download our new whitepaper!
In this informative whitepaper you will learn how you can leverage our software to increase the ROl of your website. This 25 page guide provides everything you need to get started

] 6.

0y -
-'3‘- Kentico

Get the paper!

emove |ast left column eft column right column
R last left coll Add left col Add right col

23. In the View mode tab select the Live site button as shown in the following
screenshot.
L)

List Default - Search
Device QOther

Edit Preview
View

View | Validate

er. The default account is administrator with blank p: Global Admi

Products News Community Services Company Media

» Whitepaper

Download our new whitepaper!

A In this informative whitepaper you will learn how you can leverage our software to increase the ROl of your website. This 25 page guide provides everything you need to get started

Get the paper!

Email:

-: Kentico
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24. On the Live site in the Email field enter your email address and then click the Get
the paper! button as shown in the following screenshot.

N

Default -
Device

[4 [& | [el
Edit Preview Live site List
View mode

Search
Other

View | Validate

Global Administrator (admini

lManager. The default account is administrator with blank password.

test Home Products News Community Services Company Media

» Special Pages » Whitepaper

Download our new whitepaper!

In this informative whitepaper you will learn how you can leverage our software to increase the ROI of your website. This 25 page guide provides everything you need to get started

- +
Emall: thomasri@kentico.com

I Get the paper! I

]
\.l

-'.\- Kentico

25. Select the Tools tab and then Forms as shown in the following screenshot.

:.l:. Kentico

1 CMS Desk Content My d Administraton  E-commerce  Ondine marketing

& Polls “/ Translations Custom tables m %8 chat [ Message boards El f
Forms  Media Banners "§ Staging [fq File import Blogs Forums f3 Groups @ Abuse report Projects E
Content Community Collabarat
Forms [_ﬁ File import E‘] Projects
Add a new farm Import files from your computer —= Add a new project
- 8 Import files from server disk Add a new personal task
H Media View all project tasks
O® Add 3 new meadia lihran =0 Rlanc
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26. In the Forms screen for the White paper Campaign for select the Edit (Pencil) icon
as shown in the following screenshot.

Forms

@ Mew form

+ Actions Form name = Entries

# ¥ ~  ContactUs 0

& v White Paper Campaign 1

27. Validate that you see the contact information as shown in the following
screenshot.

Form Properties

» Forms » White Paper Campaign

Data | General Fields Form  Motification e-maill  Autoresponder  Security  Alternative forms  On-ine marketing

Versions

lﬁ MNew record @ Select displayed fields

- Actions WhitePaperCampaignlD - Email Form inserted Form updated

thomasr@kentico.com  1/8/2014 4:46:35 PM  1/8/2014 4:50:16 PM
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28. Validate that you receive the email as shown in the following screenshot.

E@_ Reply I’E:g_ Reply All I‘_:_"} Forward
Wed 1/8/2014 4:53 PM
Thomas Robbins

Here is your whitepaper

To Thomas Robbins

Thanks for your interest in our new whitepaper!

You can access your whitepaper using the following link

Summary

In this set of Hands on Labs we looked at how to create a landing page that allows a user
to enter their email in exchange for a free whitepaper. Specifically, we covered the
following.

e Uploading a whitepaper
e Creating a custom table using an autoresponder
e Creating the landing page

Key Resources:

e http://devnet.kentico.com/Documentation.aspx
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